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PREFACE  
 
 
This manual explains how to use the XLE/XLT OCS Modules. 
 
Copyright (C) 2008 Horner APG, LLC., 59 South State Avenue, Indianapolis, Indiana 46201.  All 
rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored 
in a retrieval system, or translated into any language or computer language, in any form by any 
means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without the 
prior agreement and written permission of Horner APG, Inc. 
 
All software described in this document or media is also copyrighted material subject to the 
terms and conditions of the Horner Software License Agreement. 
 
Information in this document is subject to change without notice and does not represent a 
commitment on the part of Horner APG. 
 
 
Cscape, SmartStack, SmartStix and CsCAN are trademarks of Horner APG.  
Ethernet is a trademark of Xerox Corporation. 
Micro SD and CompactFlash are registered trademarks of SanDisk Corporation. 
 
 
 

For user manual updates, please visit our website:  
 
North America:   
 
Tel: (+) (317) 916-4274 
Fax: (+) (317) 639-4279 
Website: https://hornerautomation.com 
Email:  techsppt@heapg.com 
 
 
Europe:  
Tel:  (+) 353-21-4321-266 
Fax: (+) 353-21-4321-826 
Website: www.horner-apg.com 
Email: technical.support@horner-apg.com 
  

https://hornerautomation.com/
mailto:techsppt@heapg.com
file:///C:/Users/mgaring/Desktop/All%20Horner%20Files/Doc_Manuals_Edited/www.horner-apg.com
mailto:tech.support@horner-apg.com
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LIMITED WARRANTY AND LIMITATION OF LIABILITY  
 

Horner APG, LLC. ("HE-APG") warrants to the original purchaser that the XLE/XLT OCS module 
manufactured by HE-APG is free from defects in material and workmanship under normal use 
and service. The obligation of HE-APG under this warranty shall be limited to the repair or 
exchange of any part or parts which may prove defective under normal use and service within 
two (2) years from the date of manufacture or eighteen (18) months from the date of installation 
by the original purchaser whichever occurs first, such defect to be disclosed to the satisfaction 
of HE-APG after examination by HE-APG of the allegedly defective part or parts. THIS 
WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES EXPRESSED OR IMPLIED 
INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR USE AND OF ALL 
OTHER OBLIGATIONS OR LIABILITIES AND HE-APG NEITHER ASSUMES, NOR AUTHORIZES 
ANY OTHER PERSON TO ASSUME FOR HE-APG, ANY OTHER LIABILITY IN CONNECTION WITH 
THE SALE OF THIS XLE/XLT OCS module. THIS WARRANTY SHALL NOT APPLY TO THIS 
XLE/XLT OCS module OR ANY PART THEREOF WHICH HAS BEEN SUBJECT TO ACCIDENT, 
NEGLIGENCE, ALTERATION, ABUSE, OR MISUSE. HE-APG MAKES NO WARRANTY 
WHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT SUPPLIED BY HE-APG. THE 
TERM "ORIGINAL PURCHASER", AS USED IN THIS WARRANTY, SHALL BE DEEMED TO MEAN 
THAT PERSON FOR WHOM THE XLE/XLT OCS module IS ORIGINALLY INSTALLED. THIS 
WARRANTY SHALL APPLY ONLY WITHIN THE BOUNDARIES OF THE CONTINENTAL UNITED 
STATES. 
 
In no event, whether as a result of breach of contract, warranty, tort (including negligence) or 
otherwise, shall HE-APG or its suppliers be liable of any special, consequential, incidental or 
penal damages including, but not limited to, loss of profit or revenues, loss of use of the 
products or any associated equipment, damage to associated equipment, cost of capital, cost 
of substitute products, facilities, services or replacement power, down time costs, or claims of 
original purchaser's customers for such damages. 
 
To obtain warranty service, return the product to your distributor with a description of the 
problem, proof of purchase, post paid, insured and in a suitable package. 
 

ABOUT PROGRAMMING EXAMPLES  
 

Any example programs and program segments in this manual or provided on accompanying 
diskettes are included solely for illustrative purposes. Due to the many variables and 
requirements associated with any particular installation, Horner APG cannot assume 
responsibility or liability for actual use based on the examples and diagrams. It is the sole 
responsibility of the system designer utilizing the XLE/XLT OCS module to appropriately design 
the end system, to appropriately integrate the XLE/XLT OCS module and to make safety 
provisions for the end equipment as is usual and customary in industrial applications as defined 
in any codes or standards which apply. 
 

NOTE: The programming examples shown in this manual are for illustrative  
purposes only. Proper machine operation is the sole responsibility of the  
system integrator. 
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VISUAL MAP OF MAJOR TASKS AND THE KEY CHAPTERS 
 
 

FIRST STEP of ANY TASK: DATASHEET 
The datasheet is the first document to refer to for model-specific information related to 
XLE/XLT models fory installation information. The web version of this manual has all of the 
XLE/XLT datasheets attached to it. Visit the website to obtain updates to datasheets and 
user documentation. 
 
North America           https://hornerautomation.com  
Europe                        http://horner-apg.com 
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CHAPTER 1: SAFETY AND COMPLIANCE 
 
1.1 Safety Warnings and Guidelines 
 
When found on the product, the following symbols specify:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

• All applicable codes and standards need to be followed in the installation of this product. 
• For I/O wiring (discrete), use the following wire type or equivalent: Belden 9918, 18 AWG 

or larger.  
  

 Warning: Consult user documentation. Warning: Electrical Shock Hazard. 

WARNING: EXPLOSION HAZARD – Substitution of components may impair suitability for 
Class I, Division 2. 
 
WARNING: EXPLOSION HAZARD – Do not disconnect equipment unless power has been 
switched off or the area is known to be non-hazardous. 
 
WARNING: To avoid the risk of electric shock or burns, always connect the safety (or earth) 
ground before making any other connections.  
 

WARNING: To reduce the risk of fire, electrical shock, or physical injury it is strongly 
recommended to fuse the voltage measurement inputs. Be sure to locate fuses as close to 
the source as possible. 
 

WARNING: Replace fuse with the same type and rating to provide protection against risk of 
fire and shock hazards.  
 

WARNING: In the event of repeated failure, do not replace the fuse again as a repeated 
failure indicates a defective condition that will not clear by replacing the fuse.  
 

WARNING: Only qualified electrical personnel familiar with the construction and operation 
of this equipment and the hazards involved should install, adjust, operate, or service this 
equipment. Read and understand this manual and other applicable manuals in their entirety 
before proceeding. Failure to observe this precaution could result in severe bodily injury or 
loss of life. 
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Adhere to the following safety precautions whenever any type of connection is made to the 
module.  
 

• Connect the green safety (earth) ground first before making any other connections.  
• When connecting to electric circuits or pulse-initiating equipment, open their related 

breakers. Do not make connections to live power lines.  
• Make connections to the module first; then connect to the circuit to be monitored.  
• Route power wires in a safe manner in accordance with good practice and local codes. 
• Wear proper personal protective equipment including safety glasses and insulated 

gloves when making connections to power circuits.  
• Ensure hands, shoes, and floors are dry before making any connection to a power line.  
• Make sure the unit is turned OFF before making connection to terminals. Make sure all 

circuits are de-energized before making connections.  
• Before each use, inspect all cables for breaks or cracks in the insulation. Replace 

immediately if defective. 
 
 
1.2 Grounding  
 
Grounding is covered in various chapters within this manual.  
 

▪ For grounding specifications and testing for a good ground, refer to How to Test for 
Good Ground. 

▪ For panel grounding, refer to  Factors that Affect Panel Layout.  
 
 
1.3 CE Compliance  
 
To check for compliance and updates, visit our website.  
North America      https://hornerautomation.com/certifications  
Europe                   http://www.horner-apg.com/en/support/certification.aspx  
 
  

https://hornerautomation.com/certifications
http://www.horner-apg.com/en/support/certification.aspx
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CHAPTER 2: INTRODUCTION  
 
2.1 Visual Overview of XLE/XLT and Topics Covered in this Manual  
 
 

 
 

Figure 2.1 – Visual Overview of XLE/XLT  
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2.2 Where to Find Information about the XLE/XLT  
 
a. Datasheets - The datasheets are the first documents to refer to for key information related 
to specific XLE/XLT models. (A basic datasheet is provided in the box with the unit.) Datasheets 
for each model can be found on our website. See below.  
 

Table 2.1 – Datasheet Manual Numbers 
Model 0 MAN1112 
Model 2 MAN1113 
Model 3 MAN1114 
Model 4 MAN1115 
Model 5 MAN1116 
Model 6 MAN1117 

 
 
 
b. User Manual -This manual provides general information that is common to XLE/XLT models 
and can be downloaded from our website. Visit our website to obtain user documentation and 
updates. 
 
North America   https://hornerautomation.com  
Europe   www.horner-apg.com  
 
Four main types of information are covered in the manual. 
 

▪ Safety and Installation guidelines / instructions (Mechanical and Electrical) 
▪ Descriptions of hardware features (Serial ports, Removable Media, Communication 

Options, etc.) 
▪ Configuration and Use of the XLE/XLT 
▪ Maintenance and Support 

 
  

https://hornerautomation.com/
http://www.horner-apg.com/
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2.3 Connectivity to the XLE/XLT  
 
The XLE/XLT has tremendous capabilities for connecting to a variety of devices. The diagram below 
shows some examples of devices that can be used with the XLE/XLT. XLEe/XLTe have Ethernet options. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 2.2 –Overview of Types of Devices that can be connected to XLE/XLT 
  

 
CAN 

 
Serial 

 
I/O 

XLE/XLT 

Other OCS Devices 
Drives 
PLCs 

Bar Code Readers 
Printers 
SCADA 

OPC Servers 
Serial I/O 

 

Sensors 
Indicators 

Alarms 
Encoders 

Pumps 
Relays 

Solenoids 
 

Other OCS Devices 
SmartStix I/O 

SmartBlock I/O 
SmartRail I/O 

 
USB 

Ethernet 
Options Other OCS Devices 

Drives 
PLCs  
SCADA 
OPC Server 
Portal 
I/O Devices 
SmartRail Devices 

USB Slave 
Programming/ 
Monitoring Port 



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  14 | 168 
 

2.4 Features of XLE/XLT    
 
The XLE/XLT is an all-in-one industrial control device. It combines control, user interface, I/O 
and networking into a single, integrated package. Unique features of the XLE/XLT include: 
 

• Bright, graphical LCD display (in XLE) (with touch sensing in XLT) 
• Display of complex graphical objects including trends, gauges, meters and animations 
• Advanced control capabilities including floating point, multiple auto-tuning PID loops 

and string handling capabilities 
• Removable media for up to two terabytes of storage of programs, data logging or screen 

captures 
• CsCAN networking port (optional) for communication with remote I/O, other controllers 

or PCs. 
• Ethernet version (XLEe/XLTe) with native Ethernet for communication with other 

controllers, drives, PCs, etc. 
• Configurable serial protocols for communication to drives, PLCs, or other serial 

peripherals. 
• USB 2.0 full speed port for programming and monitoring. 
• Full featured, built-in I/O including high resolution analog, thermocouple, RTD, high-

speed counters, PWM outputs, and relays (depending upon the XLE/XLT model used). 
• Cscape programming software that allows all aspects of the XLE/XLT, XLEe/XLTe to be 

programmed and configured from one integrated application. 
• Optional communication add-on modules that allow additional capabilities such as 

Ethernet (pre-Rev TA only) or modems. 
• Fail – Safe System which allows an application to continue running in the event of “Soft” 

failures such as (Battery power loss or Battery Backed register RAM / Application Flash 
corruption) 

• Clone Unit allows the user to “clone” the OCS of the exact same model. This feature 
“clones” application program and unit settings stored in Battery backed RAM of an OCS. 
It can then be used to clone a different OCS (exact same model). 
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2.5 Accessories  
 
Please visit the Horner Control Accessories website for communication, programming, and I/O 
accessories.   
 
North America      http://hornerautomation.com/product-category/home/control-accessories/ 
Europe                   http://horner-apg.com/en/products.aspx 
 
 
 
2.6 Useful Documents and References 
 
Visit our website to obtain user documentation, supplemental documents, certificates, and 
other documentation.  
 
North America          https://hornerautomation.com  
Europe                       http://www.horner-apg.com 
 
 
2.7 Opening Cscape Help File  
 
After opening the Cscape Help file, either use the Contest, Index or Search tabs to located 
information. The Cscape Help file has more information than the scope of this user manual.  
 
   
 
Select “Index” tab.  
 
 
 
 
  

http://hornerautomation.com/product-category/home/control-accessories/
http://horner-apg.com/en/products.aspx
https://hornerautomation.com/
http://www.horner-apg.com/
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CHAPTER 3: MECHANICAL INSTALLATION 
 
NOTE: The datasheet is the first document to refer to for model-specific information related 
to XLE/XLT models such as pin-outs, jumper settings, and other key installation information. 
Visit our website to obtain datasheets, user documentation, and updates. 
 
North America          https://hornerautomation.com  
Europe                       http://www.horner-apg.com 
 
 
3.1 Overview  
 
The mechanical installation greatly affects the operation, safety, and appearance of the system. 
Information is provided to mechanically install the unit such as cut-out sizes, mounting 
procedures, and other recommendations for the proper mechanical installation of the unit. 
 
 
3.2 Mounting Requirements  
 
XLE/XLT products can be mounted through a panel or on DIN rail.   
 
3.2.1 Mounting Procedures (Installed in a Panel Door)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.1 – Panel Mounting of the XLE/XLT and Close-up View of Back 
  

 

 

001XLE055

https://hornerautomation.com/
http://www.horner-apg.com/
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Once the panel design has been completed using the criteria and suggestions in the following 
sections, use the following steps to panel mount the XLE/XLT. 
 
1.  Remove all connectors from the XLE/XLT unit. 
2. Press the DIN rail clip up to make passing the unit through the cutout easier. 
3. Make sure the gasket is installed on the XLE/XLT and is free from dust and debris. Check that 

the corners of the gasket are secure.  
4. Pass the unit through the panel. 
5. Insert the each of the four (4) mounting clips into the slots in the XLE/XLT case. One clip 

should be installed on each corner. Lightly tignten each screw so the clip is held in place.  
6. Tighten the screws on the clips such that the gasket is compressed against the panel.  

Recommended torque is 7-10 in-lbs [0.8-1.13 Nm]). 
 
 
3.2.2 Mounting Procedures (Installed on DIN Rail) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.2 – DIN Rail Mounting of the XLE/XLT 
 
The XLE/XLT is designed to clip onto standard 35mm DIN rail. If your installation requires 
liquid or dust protection, make sure the XLE/XLT is placed in an appropriate sealed panel 
when mounting on DIN rail. Use the following steps to mount the XLE/XLT on DIN rail. 
 

1. Move the DIN rail clip to the lower position. 
2. Clip the “Top Clips” on the top of the DIN rail. 
3. Press the unit into place and press the DIN rail clip up. A small flat-head screwdriver 

can be used in the slot of the DIN rail clip if clearance is an issue. 
 
NOTE: The DIN rail connection does not provide an earth ground. Refer to the Electrical 
Installation chapter for proper grounding information. 
  

DIN 
Rail Clip 

Top 
Clip 

NOTE: Mount the XLE/XLT with 
the DIN Rail in the horizontal 
position to avoid slippage. 
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3.3 Mounting Orientation  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.3 – Orientation of XLE/XLT OCS 
 
 
NOTE:  For panel or DIN rail mounting – The orientation shown above provides optimum legibility 
of the screen and ease of use of the keypad.   
 
CAUTION: For DIN rail mounting – To prevent the unit from slipping off the DIN rail, do NOT 
install the unit on its side as shown.  Be sure the DIN rail is in the horizontal position.  
 
 
 
 
 
 

  

001XLE056



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  19 | 168 
 

3.4 Panel Cut-Out 
 
For installations requiring NEMA4X liquid and dust protection the panel cutout should be cut 
with a tolerance of +/- 0.005” (0.1 mm). The XLE/XLT is designed to fit  

1

4
 DIN panel openings. 

There are a number of punches and enclosures designed to accommodate opening of this size. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.4 – XLE/XLT Panel Cut-out 
 
 
3.5 Dimensions 
 
 
 

         XLT         XLE 
  
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.5 – XLE/XLT Dimensions 
 
NOTE: When the communication add-on modules are installed such communication and I/O, the 
depth of the product increases from 2.264” (57.5mm) to 2.68” (68mm). 
 
NOTE: The keypad overlay appearance may differ.   

3
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2
2
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9
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3.622 [92mm]

001XLE002

 



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  20 | 168 
 

3.6 Factors Affecting Panel Layout Design and Clearances   
 
WARNING:  It is important to follow the requirements of the panel manufacture and to follow 
all applicable electrical codes and standards.  
 
The designer of a panel layout must assess the requirements of a particular system and to 
consider the following design factors.  
 
3.6.1 Clearance / Adequate Space  
 
Install devices to allow sufficient clearance to open and close the panel door. 
 

Table 3.1 – Minimum Clearance Requirements for Panel Box and Door 
Minimum Distance between base  

of device and sides of cabinet 
2” (50.80mm) 

Minimum Distance between base  
of device and wiring ducts 

1.5” (38.10mm) 

If more than one device installed in panel box 
 (or on door): 

Minimum Distance between bases of each device 
4” (101.60mm) between bases of each device  

When door is closed: 
Minimum distance between device and closed door 

(Be sure to allow enough depth for XLE/XLT.) 
2” (50.80mm) 

 
 
3.6.2 Grounding  
 
WARNING: Be sure meet the ground requirements of the panel manufactuer and also meet 
applicable electrical codes and standards.  
 

Panel box: The panel box must be properly connected to earth ground to provide a good 
common ground reference.  

 
Panel door: Tie a low impedance ground strap between the panel box and the panel door 
to ensure that they have the same ground reference. 

 
 
3.6.3 Temperature / Ventilation 
 

Ensure that the panel layout design allows for adequate ventilation and maintains the 
specified ambient temperature range. Consider the impact on the design of the panel 
layout if operating at the extreme ends of the ambient temperature range. For 
example, if it is determined that a cooling device is required, allow adequate space and 
clearances for the device in the panel box or on the panel door. 
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3.6.4 Orientation 
 

When panel-mounted, there are no orientation restrictions on the XLE/XLT. However, 
the orientation shown in Figure 3.3 provides for optimum legibility of the screen and 
ease of use of the keypad. When DIN Rail mounted, observe the orientation shown in 
Figure 3.3  

 
3.6.5 Noise  
 

Consider the impact on the panel layout design and clearance requirements if noise 
suppression devices are needed. Be sure to maintain an adequate distance between 
the XLE/XLT and noisy devices such as relays, motor starters, etc. 

 
3.6.6 Shock and Vibration  
 

The XLE/XLT has been designed to operate in typical industrial environments that may 
inflict some shock and vibration on the unit. For applications that may inflict excessive 
shock and vibration please use proper dampening techniques or relocate the XLE/XLT 
to a location that minimizes shock and/or vibration. 

 
3.6.7 Panel Layout Design and Clearance Checklist 
 

The following list provides highlights of panel layout design factors.  
 

✓ Meets the electrical code and applicable standards for proper grounding, etc.? 
 

✓ Meets the panel manufacturer’s requirements for grounding, etc.? 
 

✓ Is the panel box properly connected to earth ground? Is the panel door properly 
grounded? Has the appropriate procedure been followed to properly ground the devices 
in the panel box and on the panel door?  

 

✓ Are minimum clearance requirements met?  Can the panel door be easily opened and 
closed? Is there adequate space between device bases as well as the sides of the panel 
and wiring ducts?  

 

✓ Is the panel box deep enough to accommodate the XLE/XLT?  
 

✓ Is there adequate ventilation? Is the ambient temperature range maintained? Are 
cooling or heating devices required?   

 

✓ Are noise suppression devices or isolation transformers required? Is there adequate 
distance between the base of the XLE/XLT and noisy devices such as relays or motor 
starters? Ensure that power and signal wires are not routed in the same conduit. 

 

✓ Are there other requirements that impact the particular system, which need to be 
considered? 
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CHAPTER 4: ELECTRICAL INSTALLATION 
 
NOTE: The datasheet is the first document to refer to for model-specific information related 
to XLE/XLT models for key installation information. Visit our website to obtain datasheets, 
user documentation, and updates. 
 
North America          https://hornerautomation.com  
Europe                       http://www.horner-apg.com 
 
 
4.1 Grounding Definition 
 
Ground: The term Ground is defined as a conductive connection between a circuit or piece of 
equipment and the earth. Grounds are fundamentally used to protect an application from 
harmful interference causing either physical damage such as by lightning or voltage 
transients or from circuit disruption often caused by radio frequency interference (RFI). 
 
4.2 Ground Specifications 
 
Ideally, a ground resistance measurement from equipment to earth ground is 0Ω. In reality it 
typically is higher. The U.S. National Electrical Code (NEC) states the resistance to ground 
shall not exceed 25Ω. Horner Automation recommends less than 15Ω resistance from the 
equipment to ground. Resistance greater than 25Ω can cause undesirable or harmful 
interference to the device. 
  

https://hornerautomation.com/
http://www.horner-apg.com/
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4.3 How to Test for Good Ground 
 
In order to test ground resistance, a Ground Resistance Tester must be used. A typical Ground 
Resistance Meter Kit contains a meter, two or three wire leads, and two ground rods. 
Instructions are supplied for either a two-point or a three-point ground test.  Figure 4.1 shows 
a two-point ground connection test. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.1 – Two-Point Ground Connection Test  

METAL WATER PIPE OR
OTHER GOOD GROUND

GROUND ROD

GROUND
DISCONNECTED
FROM SERVICE

GROUND RESISTANCE METER
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4.4 Primary Power Port  
 

Table 4.1– Primary Power Port Pins 

Pin Signal Description 
1  Frame Ground 

2 0V Input power supply 0V 

3 +10 to 30VDC Input power supply positive voltage 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.2 – Power Connector (Primary Power Port) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.3 – As Viewed Looking at the XLE/XLT 

001NX002 

PIN 1 
PIN 2 
PIN 3 

+ - 
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CHAPTER 5: SERIAL COMMUNICATIONS  
 
5.1 Overview 
 
All XLE/XLT models provide two serial ports, which are implemented with 8-pin modular RJ45 
connectors and are labeled MJ1 and MJ2. The MJ1 serial port is normally used for XLE/XLT 
programming by connecting it to the COM port of a PC running Cscape. In addition, both MJ1 
and MJ2 can be used for application-specific communication, using a variety of standard data 
exchange protocols. 
 
 
5.2 Port Descriptions 
 
The MJ1 serial port contains both a half-duplex RS-485 interface and an RS-232 interface with 
RTS/CTS handshaking.   
 
NOTE: MJ1 shares its serial port with the optional COM module, so when an optional Modem 
COM or other module is installed and active, the MJ1 connector is inactive. 
 
The MJ2 serial port contains both a full-duplex RS-485 interface and an RS-232 interface with 
no handshaking. Both the MJ1 and MJ2 RS-485 interfaces provide switchable termination and 
bias resistors internally. Also, both MJ1 and MJ2 can be set as the serial programming port.  
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5.3 Serial Port Wiring & Dip Switches 
 
MJ1 Wiring 

 
 

MJ2 Wiring 

 
Dip Switches  
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5.4 RS-485 Termination  
 
Proper RS-485 termination minimizes reflections and improves reliability. 
 
Both serial ports allow an internal 121Ω RS-485 termination resistor to be placed across pins 1 
and 2. This can be done by installing a jumper / switching the dip switch. Please refer to the 
XLE/XLT data sheet for jumper / switch locations. 
 
NOTE: Only the two devices physically located at the endpoints of the RS-485 network should 
be terminated. 
 
5.5 RS-485 Biasing  
 
RS-485 biasing passively asserts a line-idle state when no device is actively transmitting, 
which is useful for multi-drop RS-485 networking. 
 
Both serial ports allow internal 390 Ω RS-485 bias resistors to be switched in, pulling pin 1 up 
to 3.3V and pin 2 down to ground. The Set Serial Ports item in the System Menu chapter can 
be used to enable RS-485 biasing. Also, an application graphics screen that writes to %SR164 
can do the same thing. Setting %SR164.1 enables MJ1 biasing and setting %SR164.2 enables 
MJ2 biasing. 
 
If biasing is used, it should be enabled in only one of the devices attached to the RS-485 
network. 
 
 
5.6 Cscape Programming via Serial Port   
 
If a PC COM port is connected to the XLE/XLT MJ1 serial port, Cscape can access the XLE/XLT 
for programming and monitoring. 
 
 
5.7 Ladder-Controlled Serial Communication  
 
Using Serial Communication function blocks, both MJ1 and MJ2 support Generic, Modbus 
Master and Modbus Slave Protocols. In addition, external modems can be connected and 
accessed using Init, Dial and Answer Modem function blocks. 
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5.8 Configuration via USB 
 
It is possible to load the program and monitor data via the USB 2.0 slave port on XLE/XLT Rev 
T and later. To load via USB, configure the communications port in Cscape as follows, the unit 
must be connected via the USB mini-USB port to the PC or laptop: 
 
Select Tools from the Toolbar 
Select Applications Settings → Communications. 
Select the USB button. 
 
It is possible to download/upload and use the data monitoring functions once connected. 
 
NOTE: It is advisable to use an isolated USB cable between the PC/laptop and the XLE/XLT 
when third party devices are connected to the XLE/XLT to avoid damaging ground loops to 
the PC/laptop and/or the XLE/XLT. 
 
  



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  29 | 168 
 

CHAPTER 6: CAN COMMUNICATIONS 
 
NOTE: For additional CAN information, refer to the CAN Networks manual (MAN0799) on the 
website. 
 
North America          https://hornerautomation.com  
Europe                       http://www.horner-apg.com 
 
6.1 Overview 
 
Some XLE/XLT models (XE1xx) provide a CAN networking port, which is implemented with a 5-
pin connector, labeled CAN 1. 
 
The CAN1 port allows the XLE/XLT OCS to exchange global data with other OCS/RCS 
controllers and to access remote Network I/O devices (SmartStix, Smart Blocks and Smart 
Rail Modules). 
 
The CAN1 port also supports pass-through communications for programming multiple OCS 
controllers over the CsCAN network. 
 
The CAN 1 port also allows the XLE/XLT to exchange global data with other OCS/RCS controllers 
and to access remote Network I/O devices (SmartStix Modules).   
 
 
6.2 Port Description 
 
The XLE/XLT CAN 1 port implements the ISO 11898-2 physical layer and the CAN 2.0A data link 
layer standards. Also, since the CAN 1 port is powered by an internal isolated power supply, 
external CAN power is not required. 
  

https://hornerautomation.com/
http://www.horner-apg.com/
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6.3 CAN Wiring and Pin Assignments 

 
 

Figure 6.1 – CAN1 Port Connector 
 
 
 
 
 
6.4 Cscape Programming via CAN 
  
The CAN 1 port supports CsCAN Programming Protocol. If a PC has a CAN interface installed 
(via PCI card or USB), and the PC CAN port is connected to the XLE/XLT CAN 1 port, Cscape can 
access the XLE/XLT for programming and monitoring. 
 
In addition, the XLE/XLT supports single-point-programming of all XLE/XLT and other OCS/RCS 
devices that are connected to a CAN network. If the PC COM port is connected to the XLE/XLT 
programming port the XLE/XLT can act as a pass-through gateway allowing Cscape to access 
all XLE/XLT and OCS/RCS devices that are attached to the CAN network. Refer to the Serial 
Communications chapter for more details.  
  

CAN Connector 
 

Use the CAN Connector 
when using CsCAN network. 

 
Torque rating: 4.5 – 7 in-lbs 

(0.50 – 0.78 N-m) 
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6.5 Ladder-Controlled CAN Communication  
 
Using Put and Get Network Words function blocks, the CAN 1 port can exchange digital and 
analog global data with other XLE/XLT or OCS/RCS devices (nodes) attached to the CAN 
network. 
 
In addition, Put and Get Network Heartbeat function blocks allow nodes on the CAN network to 
regularly announce their presence and to detect the presence (or absence) of other nodes on 
the network. 
 
 
6.6 Using CAN for I/O Expansion (Network I/O) 
 
Connecting Network I/O devices (SmartStix Modules) to the XLE/XLT CAN 1 port, allows the 
XLE/XLT I/O to be economically expanded and distributed. A variety of XLE/XLT remote I/O 
modules are available for this purpose. 
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CHAPTER 7: DOWNLOADABLE COMMUNICATION PROTCOLS 
 
7.1 Overview  

Through loadable protocol device drivers, certain models of the OCS family can provide the 
ability to exchange data with remote devices such as variable-frequency drives, PLCs, and 
remote I/O devices. This feature greatly expands the OCS’s control capability with negligible 
effect on the OCS’s ladder scan time. 
  
Remote devices that communicate serially must do so under certain rules of data transfer 
known as a protocol. Many device manufactures have created their own protocol for 
communications with their device. For an OCS to communicate with a specific device, it must 
be loaded with the corresponding serial communications protocol device driver that supports 
that protocol.  
  
A limited number of protocol device drivers are packaged with the Cscape distribution; 
however, as more are developed, they will be made available as add-on packages. A device 
driver is typically distributed as a Windows module, which contains the Configuration Menus, 
Help Files and the Target Executable Driver Code. When updating device drivers, an install 
routine loads the device driver to the Cscape directory structure and makes that driver 
available to Cscape applications. 
  
Once installed, the protocol device driver can be included as part of a Cscape application by 
selecting it from a list of installed protocol device drivers and attaching it to the desired serial 
port (Program > Protocol Config menu). Only one protocol device driver can be associated 
with a serial port, though some OCS models support multiple protocols on a single Ethernet 
port. 
  
Once the protocol is selected for a specific port, that port must be configured to match the bit 
transfer size and rate of the target device(s). This is configured under the Network Config 
menu, which contains port specific information such as the basic serial port parameters (i.e. 
baud rate, stop bits parity, retries, etc.). In addition to the serial port parameters, this menu 
also contains the transaction scan update control configuration and any network level 
protocol specific configuration. 
 
Once the network is configured, each device on the serial communications network must be 
configured. For some communications (i.e. RS232), the network can be limited to one device. 
The devices are configured under the Device Config menu, which contains an arbitrary device 
name, the device ID and optionally an OCS status register that contains any device fault 
information. 
  
Once each device(s) is configured, a Scan List of entries must be created which defines the 
transfer of data between a local (OCS) register(s) and a remote device register(s). These 
entries are created under the Data Mapping menu, which contains an OCS register, a target 
device ID, a target device register address, the number of registers to transfer, and update 
type. 
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Each entry can be configured for one of two types of initiating a transaction: Polled and 
Triggered. Polled type entries initiate a transaction with the remote device on every 
transaction scan. Triggered type entries only initiate a transaction when a corresponding local 
(OCS) binary trigger register is set. Once a triggered type transaction completes, the protocol 
device driver resets the local (OCS) binary register to indicate completion.  
 
These basic types are also subdivided into Read or Write operations. For polled operations, a 
Read operation only reads from a remote device. Likewise, a Read/Write operation 
continuously reads from the remote device unless the target OCS register value changes from 
one ladder scan to another. In this case, the new OCS value is written to the target device. For 
triggered operations, only a Read or Write action is available. 
 
When downloaded to the OCS, the Scan List is scanned sequentially to generate data 
transactions with the remote device. This transaction scanning can be on a continual basis 
(automatic) or controlled from ladder logic (manual) once a complex connection is 
programmatically created (i.e., dialup modem). The specific transaction-scanning mode is 
selected from the Network Config menu. 
 
The following Horner Automation websites offer OCS Protocol Software Downloads. 
 
North America http://hornerautomation.com/support-files/ 
Europe   http://horner-apg.com/en/products/software/ocs-protocols.aspx 

Please refer to the Cscape Help file for more information on Downloadable Protocols 
Configuration. After opening the Cscape Help file, select Contents → Networking and 
Communications → Protocol Configuration.  
 
 

  

http://hornerautomation.com/support-files/
http://horner-apg.com/en/products/software/ocs-protocols.aspx
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7.2 Protocol Config 

After opening Cscape, choose Program → Protocol Config.   
 

 
 
 
Then select a protocol device driver from the dropdown box. All protocol device drivers 
currently loaded in Cscape are displayed in the dropdown selection. Some OCS models can be 
limited in the number of ports or number of protocol device drivers that can be selected. Once 
a protocol is selected, the Network, Devices, and Data (Scan List) must be configured through 
corresponding dialogs accessible through the respective buttons (Network, Device, and Scan 
List.)  
 

 

Figure 7.1 – Protocol Config Dialog  
 
Three fields must be configured after a protocol is selected:  

1. Network 
2. Devices 
3. Scan List  
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7.3 Network Configuration 
 
For Network Configuration, first select an option from the dropdown menu.  Then click the 
Network button.  
 

 
 
Network Configuration provides the required parameters to configure the network. Each 
protocol is different and may not require the entire Network Config field. Please refer to the 
table below for the options in the Network Config field.  
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Please see the Cscape Help file for more detailed information.  

Table 7.1 – Network Protocols  
Baud Rate, Data Bits, Stop 
Bits, Parity 

These field define the bit level transfer over the serial port.  

 
Handshake 

None – No handshake lines are used 
Multidrop Full – Rx remains active while Tx is occurring.  
Multidrop Half – Rx is shut off while Tx is occurring.  
Radio Modem – Wait for CTS acknowledgement before 
transmitting (legacy radio modem support).  

Protocol If a driver supports multiple protocols, it is selected here, 
(i.e. Modbus supports RTU or ANSI). 

Mode Specifies if port operates in RS232 or RS485 mode. 
Retries Specifies number of times a transaction is retried on a failed 

response.  
Timeout Specifies the amount of time for a device to wait for a valid 

response.  
 
 
 
 
Update Scan 

 
 
Automatic 
 

Update Interval – Specifies the update interval 
at which all the mapped entries are executed.  
Reacquire Time – Specifies the amount of time 
to wait before attempting communications with 
an offline device.  

 
 
Manual 

Trigger – Specifies the binary register that a 
single transaction scan of the Scan List.  
 
ID Select – If an analog is specified in the field, 
the ID Select filter is enabled.  

Status Register Specifies the starting OCS register of eight (8) consecutive 
registers (4-32bit counters), which provide an indication of 
the network health.  

Scanner Address Specifies the OCS’s device (network) ID if a master ID is 
required by the protocol. 

Protocol Help Provides protocol specific help.  
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7.4 Device List and Device Configuration  
 
Device List 

 

 
 
 
Access the Device List (CsCAN Serial) by selecting the Device button on the Protocol Config 
screen. Devices must be created and exist in this list before corresponding Scan List entries 
can be created for this device. Typically, the number of entries is limited to 64 devices.  
 
Select the Config button when adding or modifying an existing device.   
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7.5 Scan List  
 

 
 
The Scan List (CsCAN Serial) dialog is accessed from the Scan List button on the Protocol 
Config screen and provides a Scan List of the Data Mapping entries. To transfer data between 
the OCS and remote target, a Scan List must be created that defines each transaction. Each 
mapping entry (transaction) contains the source and destination registers, the number of 
consecutive registers transferred, the direction of the transfer and what triggers the transfer. 
Typically, the number of entries is limited to 512.   
 
NOTE: The order of the Scan List is the order in which the transactions occur. Sort functions 
are provided to change the order of the list. Each entry also has an identifying index. If the 
device status register is enabled and a transaction failure occurs, the status register indicates 
the index number of the transaction that has failed.  
  



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  39 | 168 
 

7.6 Data Mapping Configuration (Scan List Entry) 

 

 
 
Update Type 
This field specifies the direction and what triggers the transfer of data between the OCS and 
target device for a mapping entry. 
  
Polled Read 
On every transaction scan, a read-only target device register(s) transaction occurs. 
  
Polled Read/Write  
On every transaction scan, a read target device register transaction occurs unless a local 
register value has changed. The write transaction only updates those local registers that have 
changed in value. If several non-consecutive local registers (contained in a single mapping 
entry) change value between transaction scans, it takes several consecutive transaction scans 
to write each changed register. 
  
When the OCS is placed in RUN mode, the initial action for this mapping type is a read target 
register transaction. This transaction initializes the local (OCS) register(s) to match that of the 
remote device register(s). Thereafter, any change to the corresponding OCS register(s) 
triggers a write operation to the remote device. 
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Polled Read/Write/Init  
On every transaction scan, a read target device register transaction occurs unless a local 
register value has changed. The write transaction only updates those local registers that have 
changed in value. If several non-consecutive local registers (contained in a single mapping 
entry) change value between transaction scans, it takes several consecutive scans to write 
each changed register. 
  
When the OCS is placed in RUN mode, the initial action for this mapping type is a write target 
register transaction. This transaction initializes the target device register(s) to match that of 
the local (OCS) register(s). Thereafter, any change to the corresponding OCS register(s) 
triggers a write operation to the remote device. 
  
The initial write transaction does not occur until after the first logic scan of the OCS. This 
allows registers to be initialized locally before Writing to the target device register(s). 
  
Triggered Read  
A read transaction is triggered by a high level on a separately designated OCS (binary) trigger 
register. Once the read transaction is complete (or the device is offline), the OCS trigger 
register is cleared by the OCS. This update type can be used for occasion data accesses such 
as retrieving trend data.  
 
NOTE: This operation increases the associated transaction scan time and can cause the 
Update Interval Exceeded Counter to increment on a tightly adjusted update interval. 
  
Triggered Write  
A write transaction is triggered by a high level on a separately designated OCS (binary) 
trigger register. Once the write transaction is complete (or the device is offline), the OCS 
trigger register is cleared by OCS. This function can be used for occasion data accesses such 
as sending recipe data. 
 
NOTE: This operation increases the associated transaction scan time and can cause the 
Update Interval Time Exceeded Counter to increment on a tightly adjusted update interval. 
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CHAPTER 8: ETHERNET COMMUNICATION 
 
8.1 Ethernet Module Protocols and Features 
The following table describes the Ethernet Module protocols and features supported by the 
Ethernet port on the XLEe/XLTe: 
 

Table 8.1 – Ethernet Module Protocols / Features 
Protocol / Feature Protocol / Feature Description 

ICMP (Ping) Internet Control Message Protocol 
EGD  Ethernet Global Data 
SRTP Slave (90-30 Service 
Request) 

Service Request Transfer Protocol 

CsCAN TCP Server 
Horner APG CsCAN over Ethernet (for Cscape 
to OCS programming) 

Modbus Slave Modbus over Ethernet 
Ethernet / IP  ODVA CIP over Ethernet 
FTP (File Server) File Transfer Protocol 
ASCII Over TCP/IP ASCII Data over Ethernet 

 
 
8.2 Ethernet System Requirements  
Full Ethernet functionality requires: 

- PC running Cscape Programming Software Version 9.8 or later (for configuration). 
- XLE/XLT controller with onboard Ethernet port. 

 
 
8.3 Ethernet Module Specifications 
 

Table 8.2 – Ethernet Module Specifications 

Speeds 
10 BaseT Ethernet (10Mbps) 
100 BaseTx Fast Ethernet (100Mbps) 

Modes Half or Full Duplex 
Auto-Negotiation Both 10/100Mbps and Half/Full Duplex 
Connector Type Shielded RJ-45 
Cable Type 
(Recommended) 

CAT5 (or better) UTP 

Port Auto MDI/MDI-X (Auto Crossover) 
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8.4 Ethernet Module Configuration 
NOTE: The following configuration is required for all applications regardless of the protocols 
used. Additional configuration procedures must be performed for each protocol used. 
 
To configure the Ethernet Module, use Cscape Programming Software to perform the following 
steps: 
 

1. On the main Cscape screen, select the Controller menu and its Hardware 
Configuration sub-menu to open the Hardware Configuration dialog (Figure 8.1). 

2. Click the Config button to the right of LAN1, revealing the Ethernet Module 
Configuration dialog as shown in Figure 8.3  

 

 
Figure 8.1 – Hardware Configuration Dialog 
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NOTE: If configuring a different OCS Model than the XLEe, click on the arrow to show other OCS 
models. Select the desired OCS Model, and then click OK. 
 

 
Figure 8.2 – Hardware Configuration Dialog 
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Figure 8.3 – Ethernet Module Configuration 

 
 
3. Configure the Ethernet Module parameters as follows: 
 
IP Address: Enter the static IP Address for the Ethernet Module being configured. 
 

NOTE: IP Addresses are entered as four numbers, each ranging from 0 to 255. These 
four numbers are called octets and they are always separated by decimal points. 

 
Net Mask: Enter the Net Mask (sometimes called Subnet Mask) being used by all nodes on the 
local network. Typical local networks use Class C IP Addresses, in which case the low octet 
(rightmost number) is used to uniquely identify each node on the local network. In this case, 
the default Net Mask value of 255.255.255.0 should be used. 
 
Gateway: Enter the IP Address of a Gateway Server on the local network that allows for 
communication outside of the local network. To prevent the Ethernet Module from 
communicating outside the local network, set the Default Gateway IP Address to 0.0.0.0 (the 
default setting). 
 
Status Register: Enter an OCS Register reference (such as %R100) to indicate which 16-bit OCS 
register will have the Ethernet Status word written to it. Table 8.3 shows how this register value 
is formatted and explains the meaning of each bit in the Status Word.  
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Table 8.3 - Ethernet Status Word Register Format 

High Byte Low Byte 
Bit 
16 

Bit 
15 

Bit 
14 

Bit 
13 

Bit 
12 

Bit 
11 

Bit 
10 

Bit 
9 

Bit 
8 

Bit 
7 

Bit 
6 

Bit 
5 

Bit 
4 

Bit 
3 

Bit 
2 

Bit 
1 

0 0 Dup Spd 0 Rx Tx Link TCP Connections 

Status Bit(s) Status Indication 
Status Values 

Minimum Maximum 
0 Reserved Always 0 

Dup Link Duplex (Auto-Negotiated) 
0 = Half 
Duplex 

1 = Full 
Duplex 

Spd Link Speed (Auto-Negotiated) 0 = 10MHz 1 = 100MHz 
Rx Receive State 0 = Inactive 1 = Active 
Tx Transmit State 0 = Inactive 1 = Active 

Link Link State 0 = Down 1 = Up 

TCP Connections 
Total Number of Active TCP 

Connections 
(CsCAN, SRTP, Modbus, EIP, FTP) 

0 40 

 
Version Register: Enter an OCS Register reference (such as %R101) to indicate which 16-bit OCS 
register will have the Ethernet Firmware Version written to it. The value stored in the Version 
Register is (Ethernet Firmware Version * 100). For example, for Ethernet Firmware Version 4.77, 
the version register will contain 477. 
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Get Settings From:   
“Get settings from” allows the programmer to either configure the IP Address, Net Mask, or 
Gateway for two functions: Configuration or Register. 
 
1. Configuration – The configuration for the IP Address, Net Mask, or the Gateway will be assigned 
using the value in the Default Settings in this window. 
 
2. Register – The configuration for the IP Address, Net Mask, or the Gateway will be assigned 
using the values in the registers assigned.  
 
NOTE: The low octet of the IP Address can be replaced with the unit’s CAN Network ID, by 
checking the Use CAN ID for last Octet checkbox. 
 
 
8.5 Ethernet Configuration – IP Parameters   

 
For primary operation, the IP address, Net Mask, and Gateway should be set in the LAN Config 
of the Cscape Hardware Configuration. There are options to get IP parameters from the LAN 
Config or to get parameters from registers. It is possible to set the Ethernet IP parameters 
from the OCS System Menu, but only as a temporary measure. The following points on IP 
parameter configuration should be considered. 
 

• IP Parameters in Non-Volatile RAM: The IP parameters of the Cscape LAN Config are 
written to non-volatile RAM on power down.  IP parameter settings made in the System 
Menu are not written to non-volatile RAM.  Any IP parameters settings made in the 
system menu will be lost after cycling power to the unit. It will revert back to the last 
downloaded Cscape LAN Config that was loaded into non-volatile RAM at power down. 
 

• “Cscape LAN Config”/ “Get Settings from” Configuration: When ‘Get settings from’ is 
set to Configuration, the IP parameters specified under ‘Default Settings’ is used after 
downloading to the controller. The IP parameters are represented in System Menu / 
Set Networks and can be edited. However, any edits made from System Menu / Set 
Networks is not retained through a power cycle. After power cycle, the unit reverts to 
the last downloaded Cscape LAN Config that was loaded into non-volatile RAM at 
power down. 
 

• “Cscape LAN Config” / “Get Settings from” Register: When ‘Get settings from’ is set to 
Register, the IP parameters are retrieved from the OCS registers assigned in LAN 
Config. Configured registers must be populated with the desired IP parameters. 
The IP parameters are represented in System Menu / Set Networks. 
The IP parameters cannot be edited from System Menu / Set Networks while the unit is 
in run mode. 
The IP parameters always follow the values in the registers unless the OCS unit is 
placed in idle mode. Then the IP parameters can be edited in System Menu / Set 
Networks. When the OCS is placed back into run mode, it reverts to the registers for IP 
parameters.  
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8.6  Ethernet Module Protocol Configuration 
 
The Protocol Support area contains a list of all the protocols supported by the platform being 
configured. To activate a protocol, check its checkbox. 
  
For protocols that require additional configuration, click on a listed protocol to select it and 
then click the Configure Selected Protocol button. This will open a new dialog with configuration 
options for the selected protocol. 
 
For detailed information on individual protocol configuration refer to the latest version of the 
ETN 300 Manual SUP0740. 
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CHAPTER 9   SYSTEM SETTINGS AND ADJUSTMENTS 
 
9.1 System Menu - Overview 
 
The XLE/XLT controller has a built-in System Menu, which lets the user view System Settings 
and make adjustments. To start the System Menu, press the  and  keys at the same time (or 
set %SR3 to 1), which will display the Main Menu. Then use the  and  keys to select a Main 
Menu item and press Enter to display the item’s Sub-Menu. 
 
NOTE: The XLE display shows up to six (6) lines of text at a time. For System Menu screens that 
contain more than 6 lines of text, use the  and  keys to scroll the display. 
 
NOTE: The XLT display shows up to 12 lines of text at a time. For System Menu screens that 
contain more than 12 lines of text, scroll the display. 
 
 
9.2 System Menu – Navigation and Editing 
 
As mentioned above, the System Menu is started by pressing the  and  keys at the same time 
for the XLE, or the System key on the XLT. Then, either press ESC to exit the System Menu, or 
use the  and  keys to select an item and press Enter to display the item’s Sub-Menu. 
 
A Sub-Menu generally shows a list of System Settings and their values. After opening a Sub-
Menu, if any of its System Settings are editable, the first System Setting that can be edited is 
highlighted. If desired, the  and  keys can be used to select a different System Setting to be 
edited. 
 
At this point, either press ESC to exit the Sub-Menu (returning to the Main Menu) or press Enter 
to edit the highlighted System Setting. If Enter is pressed, the System Setting’s value will be 
highlighted, indicating that it is ready to be modified. 
 
When modifying a System Setting’s value, use either the arrow keys ( →  ) or the numeric 
keys, or the appropriate touch screen icons to select a new value. 
 
The arrow keys are used to edit System Settings that have just a few possible values. Each time 
the arrow key is pressed, a new possible value is displayed. When the desired value appears, 
press the Enter key to save it; otherwise press the ESC key to cancel the edit. 
 
The numeric keys are normally used to enter numeric System Settings. In addition, to edit a 
single numeric digit, use the  or → key to select the digit and then either press a numeric key 
or use  or  to modify the digit. In any case, after entering the new desired value, press the 
Enter key to save it; otherwise press the ESC key to cancel the edit. 
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Ladder Size:      2 

Config Size:      8 

Graphics Sz:      8 

String Size:      8 

Bitmap Size:      8 

Text Size:        8 

Font Size:        8 

Protocol Sz:      8 

SMS Msg Sz:       8 

Firmware Rev: 11.59 

CPLD Rev:       1.5 

Self-Test:       Ok 

System RAM:      Ok 

System BIOS:     Ok 

Firmware:        Ok 

Logic Error:     Ok 

User Program:    Ok 

User Graphics:   Ok 

W-Dog Trips:      0 

Net Errors:       0 

Network State:   Ok 

Network ID:      Ok 
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Figure 9.1 
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Figure 9.2 
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9.3 System Menu – Details  
 
The following sections describe each of the Sub-Menus in detail. 
 
Set Network ID 
 
The Network ID Sub-Menu only appears for XLE/XLT models that have CAN ports (XE1xx). This 
Sub-Menu displays two System Settings of which only Network ID is editable.   
 

Network Ok? Yes = NET1 connected to a CAN network and functioning 
properly 
 No = Not ready to communicate on CAN network 
 
Network ID: 1 to 253 = This node’s CsCAN Network ID; must be unique on 
network 

 
 
 
Set Network Baud 
 
The Network Baud Sub-Menu only appears for XLE/XLT models that have CAN ports (XE1xx). 
This Sub-Menu displays just one System Setting and it is editable. 
 

Network Baud? 125kB = 125kBd CAN network 
 250kB = 250kBd CAN network 
 500kB = 500kBd CAN network 
 1 MB = 1MBd CAN network 

 
 
 
 
 
Set Contrast 
 
The Set Contrast Sub-Menu displays just one System Setting and it is editable. 
 

Contrast:  = Current display contrast setting 
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View Status 
 
The View Status Sub-Menu displays up to 17 System Settings. The Lcl Net Use % and All Net 
Use % System Settings only appear for XLE/XLT models that have CAN ports (XE1xx). Only the 
Mode System Setting is editable. 
 

Model: XExyyz    = 5 or 6 character Model number of this XLE/XLT unit 
                                                 x         = 1 for models that have a CAN port 
 0 = no CAN port 
 yy = the installed I/O module 
 00 = no I/O module 
 z = the installed COM module  
 N = no COM module 
 
Mode: Idle = XLE/XLT is in Idle mode 
 DoIO = XLE/XLT is in Do I/O mode 
 Run = XLE/XLT is in Run mode 
 
Scan Rate(mS): 0.0 = XLE/XLT is not in Run mode 
 0.1 to 999.9 = Average number of mS for each ladder scan 
 
Lcl Net Use %: 0.0 to 100.0 = CAN network bandwidth % used by this XLE/XLT node 
 
All Net Use %: 0.0 to 100.0 = CAN network bandwidth % used by all nodes 
 
Ladder Size: x = Number of bytes in application ladder program 
Config Size: x = Number of bytes in application I/O configuration 
Graphics Sz: x = Number of bytes in application graphic screens 
String Size: x = Number of bytes in application string table 
Bitmap Size: x = Number of bytes in application bitmaps 
Text Size: x = Number of bytes in application text tables 
Font Size: x = Number of bytes in application font tables 
Protocol Sz: x = Number of bytes in application downloaded protocols 
SMS Msg Sz: x = Number of bytes in application SMS protocol    
                    configuration 
Firmware Rev: xx.yy = Current firmware version 
CPLD Rev: x.y = Current CPLD (Complex Programmable Logic Device)  
  version 
Self-Test: Ok = All power-on self-tests passed 
 Fault = One or more power-on self-tests failed 
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View Diags 
The View Diags Sub-Menu displays up to 14 System Diagnostics, all of which are not editable. 
The Net Errors, Network State, Network ID and Dup Net ID System Diagnostics only appear for 
XLE/XLT models that have CAN ports (XE1xx). 
 
The first five System Diagnostics are critical. If any of them indicate a Fault condition, the 
XLE/XLT will not enter or remain in Run mode, and the problem must be investigated and 
corrected. 
 

System RAM: Ok = System RAM power-up self-test passed 
 Fault = System RAM power-up self-test failed 
 
System BIOS: Ok = System BIOS power-up self-test passed 
 Fault = System BIOS power-up self-test failed 
 
Firmware: Ok = Firmware power-up self-test passed 
 Fault = Firmware power-up self-test failed 
 
Logic Error: Ok = All executed ladder instructions are legal for loaded firmware 
 Fault = A ladder instruction not supported by firmware was found 
 
User Program: Ok = Ladder program and I/O configuration loaded successfully 
 Fault = Ladder program or I/O configuration not loaded or load failed 
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The last nine System Diagnostics are informational. If any of them indicate a Warning condition, 
the XLE/XLT can still enter and remain in Run mode, but the problem should be investigated 
and corrected. 

 
User Graphics: Ok = Application graphics objects loaded successfully 
 Fault = Application graphics objects not loaded or load failed 

 
W-Dog Trips: 0 = Watchdog timer has not tripped since the last power-up 
 x = Number of times watchdog timer has tripped 
 
Net Errors: 0 = No CAN network bus-off errors have occurred 
 x = Number of CAN network bus-off errors that have occurred 
 
Network State: Ok = At least one other node was found on the CAN network 
 Warning = No other nodes were found on the CAN network 
 
Network ID: Ok = This node’s CAN Network ID is in the range 1 to 253 
 Warning = This node’s CAN Network ID was out of range at power-up 
 
Dup Net ID: Ok = This node’s Network ID is unique on the CAN network 
 Warning = This node’s Network ID is duplicated in another node 
 
Clock Error: Ok = Time and date have been set 
 Warning = Time and date need to be set 
 
I/O System: Ok = I/O configuration matches the installed I/O and COM modules 
 Warning = I/O configuration needs updating to match installed modules 
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View I/O Slots 
 
The View I/O Slots Sub-Menu displays two System Settings, both of which are not editable. 
 
Internal to the XLE/XLT, there is a CPU board, and up to two installed modules. Models XE000 
and XE100 have no installed I/O or COM modules. All other models have an I/O module in Slot 1 
and can have a user-installed COM module in Slot 2.  
 
Depending on which I/O module is installed and which I/O module has been configured by 
Cscape, one of the following six System Settings should appear for Slot 1: 
 
Slot 1: I/O: Empty  = No I/O module installed or configured 
Slot 1:*Unsupported  = Unsupported I/O module installed 
Slot 1:-I/O Missing  = No I/O module installed but an I/O module is configured 
Slot 1:+I/O: XExyy  = yy I/O module installed but no I/O module configured 
Slot 1:?I/O: XExyy  = yy I/O module installed but another I/O module configured 
Slot 1: I/O: XExyy  = yy I/O module installed and configured properly 
 
Depending on the COM module that is installed and the COM module that has been configured 
by Cscape, one of the following six System Settings appears for Slot 2: 
 
Slot 2: I/O: Empty  = No COM module installed or configured 
Slot 2:*Unsupported  = Unsupported COM module installed 
Slot 2:-I/O Missing  = No COM module installed but a COM module is configured 
Slot 2:+I/O: XzC  = z COM module installed but no COM module configured 
Slot 2:?I/O: XzC  = z COM module installed but another COM module configured 
Slot 2: I/O: XzC  = z COM module installed and configured properly 
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View Protocols 
 
The View Protocols Sub-Menu displays two System Settings, both of which are not editable. 
 
Both the MJ1 (Port 1) and MJ2 (Port 2) serial ports support downloadable protocols. To assign 
a downloadable protocol to an XLE/XLT serial port, select the Protocol Config item in Cscape’s 
Program menu and then setup a protocol for Port 1 or Port 2 (or both). Refer to the Serial 
Communications chapter for more details.  
 
In the View Protocols Sub-Menu, the currently downloaded protocol, if any, and its version 
number are displayed for both Port 1 and Port 2. 
 

Port 1: 
Protocol name  = (None Loaded) or name of the protocol assigned to MJ1  
Protocol version  = Blank or version of the protocol assigned to MJ1 
 
Port 2: 
Protocol name  = (None Loaded) or name of the protocol assigned to MJ2  
Protocol version  = Blank or version of the protocol assigned to MJ2 
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Set Fkeys 
 
The Set Fkeys Sub-Menu displays two System Settings, both of which are editable. 
 

Fkeys: Momentary = %K1-10 bits go On & Off as F1-F10 are pressed & released 
 Toggle = %K1-10 bits toggle each time F1-F10 are pressed 
 
SYS_Fn enable: Yes = Reset and all clear system functions enabled 
 No = Reset and all clear system functions disabled 

 
 
Set Serial Ports 
 
The Set Serial Ports Sub-Menu displays three System Settings; all of which are editable, and one 
optional item. For the Dflt Pgm Port System Setting, only MJ1-232 can be selected, unless either 
an Ethernet (XEC) or a Modem (XMC) COM module is installed. Also, the Set Ethernet (Enet) 
item only appears if an Ethernet COM module is installed. 
 

Dflt Pgm Port: MJ1-232 = MJ1 RS232 port is the default programming port 
 Enet = Ethernet COM module is the default programming port 
 Modem = Modem COM module is the default programming port 
 
MJ1 RS485 Bias: No = MJ1 RS485 bias resistors are not switched in 
 Yes = MJ1 RS485 bias resistors are switched in 
 
MJ2 RS485 Bias: No = MJ2 RS485 bias resistors are not switched in 
 Yes = MJ2 RS485 bias resistors are switched in 
 
Set Ethernet (Enet)  = Select and press Enter to setup the Ethernet COM 
module 
 
 
 

Set Ethernet (Enet) (for units older than Rev TA) 
 
The Set Ethernet (Enet) Sub-Menu displays three System Settings, all of which are editable. The 
values shown below are the default values.  
 
NOTE: If Gtwy is set to 0.0.0.0, Ethernet communication will be confined to the local network. 
 

Addr: 192.168.254.128 = IP Address for installed Ethernet COM module 
Mask: 255.255.255.0 = Net Mask for installed Ethernet COM module 
Gtwy: 0.0.0.0 = Gateway device IP Address for installed Ethernet COM 
module 
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Set Time/Date 
 
The Set Time/Date Sub-Menu displays three System Settings. Time and Date are editable, and 
Day is automatically calculated from the Date setting.   
NOTE: Time and Date are split into three editable fields each. Use  or → to select a field and 
then use  or  to edit the field. 
 

Time: 10:21:36 = Current time (hours:minutes:seconds in 24-hour format) 
Date: 22-Jun-2006 = Current date (day-month-year) 
Day: Thursday = Current day of week calculated from the Date setting 

 
 
NOTE: After changing the Ethernet Addr, Mask, or Gtwy, the XLE/XLT must be power-cycled (or 

reset) before the changes take effect.  
 
 
XLT Specific:  

 

Set Beeper (XLT only)  
 
The Set Beeper Sub-Menu displays one System Setting, which is editable 
 

Beeper enable:  Yes (default)= Enables beeper   
                              No = Disables beeper (does NOT affect ladder access)  
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Removable Media 
 
XLE Specific: The Removable Media Sub-Menu displays the Removable Media. Refer to the 
Removable Media chapter for more details. After selecting Removable Media from the Main 
Menu, one of four Sub-Menu screens will appear: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Shows up to five files or directory names at a time 

   Media Directory  

No Card 

   Media Directory  

Dir Empty 

   Media Directory  

Initializing 

= No microSD card has been installed in the Memory slot 

= microSD card is installed, but it is still initializing 

= microSD card is installed and initialized, but contains 
no files 

Scrollbar only appears if displayed directory contains more than five files 
and/or directories. 

Shows size of highlighted file or shows <DIR> if directory is highlighted 
Shows the date file or directory was created or last modified 
Shows the time file or directory was created or last modified 

   Media Directory  

FILENAM1.EXT   11.7K 

FILENAM2.EXT     10-20 

FILENAM3.EXT     -05 

FILENAM4.EXT     1:09p 

FILENAM5.EXT   Free 

= microSD card is installed and initialized, and it contains 
files 



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  60 | 168 
 

 
If the Removable Media Manager displays files or directories, as in the last example above, there 
are several options available: 
 
If → is pressed, the number of total and free bytes is displayed. Then, pressing  returns to the 
normal file and directory display. 
 
If a soft key (on either side of the display) is pressed, a pop-up window appears on the right side 
of the display, showing the function key options as follows: 
 

F1 Delete  = Delete the highlighted file or directory 
F2 DelAll  = Delete all files and directories 
F3 Format  = Format the microSD card 
F4 SavPgm  = Save XLE/XLT application to DEFAULT.PGM 
Esc Cancel    = Cancel current operation (back up one screen) 

 
Pressing the soft key again or pressing ESC returns to the normal file and directory display. 
 
If a directory name is highlighted, pressing Enter will switch to that directory showing its files 
and sub-directories. In a sub-directory, highlighting .. (dot dot) and pressing Enter will move up 
one directory.  



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  61 | 168 
 

Removable Media 
 
XLT Specific:  
 
The Removable Media Sub-Menu displays the Removable Media Manager. Refer to the 
Removable Media chapter for more details.  After selecting Removable Media from the Main 
Menu, one of four Sub-Menu screens will appear: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Shows up to five file or directory names at a time 

   Media Directory  

No Card 

   Media Directory  

Dir Empty 

   Media Directory  

Initializing 

= No micro SD card has been installed in the Memory slot 

= micro SD card is installed, but it is still initializing 

= micro SD card is installed and initialized, but contains 
no files 

Scrollbar only appears if displayed directory contains more than five files 
and/or directories. 

Shows size of highlighted file or shows <DIR> if directory is highlighted 
Shows date the file or directory was created or last modified 
Shows time the file or directory was created or last modified 

= micro SD card is installed and initialized, and it contains 
files 
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If the Removable Media Manager displays files or directories, there are several options 
available: 
 

 
 

Delete          = Delete the highlighted file or directory 
DelAll           = Delete all files and directories 
Format         = Format the microSD card 
SavPgm       = Save XLT application to DEFAULT.PGM 
 

             = Enter Key 
DSK              = Shows number of total and free bytes in removable memory 

             = Up Arrow 

            = Down Arrow 

Esc            = Cancel current operation (back up one screen) 

 
Pressing Esc returns to the normal file and directory display. 
 
If a directory name is highlighted, pressing Enter will switch to that directory showing its files 
and sub-directories. In a sub-directory, highlighting .. (dot dot) and pressing Enter will move up 
one directory.  
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Fail – Safe System 
 
The Fail-Safe System is a set of features that allow an application to continue running in the 
event of certain types of "soft" failures. These "soft" failures include: 

• Battery power loss 
• Battery-Backed Register RAM or Application Flash corruption due to, for example, an 

excessive EMI event. 
 
Selecting “Fail-Safe System” menu will open the following menu screen: 
 

XLT: 

 

XLE: 

 

 
 
Selecting Backup/Restore Data displays the following screen in: 
 

XLT: 

 

XLE: 

 

 
 
Backup = Copies Battery Backed RAM contents on to the onboard flash memory of the 

OCS. 
Restore = Copies the backed-up data from onboard flash to the battery backed RAM. 
Clear Backup = The backup data will be erased from the onboard flash. 
Exit  = Goes back to previous menu. 
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AutoRun   
“Enable AutoRun” displays the following options which can be selected: 
 

XLT: 

 

XLE: 

 

 
Enable AutoRun No = OCS will be in IDLE mode after AutoLoad or Automatic Restore.     

Yes = OCS will be automatically placed into RUN mode after 
AutoLoad or Automatic Restore. 

 
AutoLoad  
 
 “Enable AutoLoad” displays the following options which can be selected: 
 

XLT: 

 

XLE: 

 

 
Enable AutoLoad No = Does not load AUTOLOAD.PGM automatically when application                   

            program is absent or corrupted. 
Yes = Loads AUTOLOAD.PGM file automatically from RM when    

application program is absent or corrupted. 
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Clone Unit 
 
 

‘Clone Unit’ feature allows the user to “clone” the OCS of the exact same model. This feature 
“clones” application program and unit settings stored in Battery backed RAM of an OCS into 
the RM. Refer to the Clone Unit chapter for more details. It can then be used to clone a different 
OCS (exact same model).  
 

This feature can be used for: 
 

• Replacing an OCS by another unit of the same model. 
• Duplicating or “clone” units without a PC. 

 

Clone 
 

Selecting “Clone Unit” menu will open the following menu screen: 
 

XLT: 

 

XLE: 

 

 

NOTE: 
 

a. In the above Figure, F3 and F4 (XLE menu) are inactive in Clone Unit. 
b. DSK – when selected shows number of total and free bytes in Removable Media. 

 
 
Selecting Make Clone brings up the screen below for the user: 
 

XLT: 

 

XLE: 
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After confirmation, the OCS will create two new files in the root directory of the Removable 
Media Drive as shown below: 
 
AUTOLOAD.PGM Application file 
CLONE.DAT  File having all unit settings and register values from Battery Backed RAM 
 

XLT: 

 

XLE: 

 

 

 
 
Load Clone 
 
Selecting “Clone Unit” menu will open the following menu screen. Select “Load Clone”. 
  

XLT: 

 

XLE: 

 

 

NOTE: For security enabled files, Load Clone asks for password validation before loading the 
application. 
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CHAPTER 10: REMOVABLE MEDIA 
 
 
10.1 Overview 
 
All XLE/XLT models provide a Removable Media slot, labelled Memory, which supports standard 
microSD Flash memory cards. microSD cards can be used to save and load applications, to 
capture graphics screens and to log data for later retrieval. 
 
10.2 microSD Cards 
 
The XLE/XLT Memory slot is equipped with a “push-in, push-out” connector and a microSD card 
can be safely inserted into the Memory slot when the XLE/XLT is powered On or Off.   
 
To install a microSD card: Align its 8-pin gold edge connector down, facing the front of the 
XLE/XLT unit as shown in Figure 10.1; then carefully push it all the way into the Memory slot. 
Ensure that it clicks into place.    
 
To remove the microSD card: Push down on the top of the card gently to release the spring. 
The card pops up for removal. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 10.1 – Installing Removable Memory Card 
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10.3 microSD File System 
 
XLE/XLT prior to Rev TA supported the FAT16 file system which allows up to 2.0 GB of flash 
memory, while XLE/XLT with REV TA and higher support the FAT32 file system which allows 
up to 2TB of flash memory. FAT microSD cards are compatible in REV TA units and higher. 
The XLEe and XLTe also support the FAT32 file system.  
 
This means that a PC, with a microSD-compatible card reader, can read files that have been 
written by the XLE/XLT and can write files that can be read by the XLE/XLT. 
 
The XLE/XLT supports the 8.3 filename format. This means that all file and directory names 
must consist of up to eight (8) characters, followed by an optional dot, and an optional 
extension with up to three (3) characters. 
 
Directories and sub-directories may be nested up to 16 levels deep as long as each pathname 
string does not exceed 147 characters. 
 
 
10.4 Using the Removable Media Manager   
 
The Removable Media Manager is an interactive XLE/XLT screen that performs the following 
functions: 
 

• Display number of total and free bytes 
• Browse file and directory lists 
• Delete files and directories 
• Format a microSD card 
• Load and save application programs 
• View screen capture bitmaps 

 
The Removable Media Manager can be accessed via the System Menu or by using Cscape to 
place a Removable Media Manager object on an application graphics screen.  Refer to the 
System Settings and Adjustments chapter for more details.  
 
 
10.5 Using Removable Media to Log Data 
 
Using Read and Write Removable Media function blocks, an application ladder program can 
read and write XLE/XLT register data in the form of comma-delimited files, with a .csv 
extension. These files are compatible with standard database and spreadsheet PC programs. 
In addition, an application ladder program can use Rename and Delete Removable Media 
function blocks to rename and delete files. 
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10.6 Using Removable Media to Load and Save Applications  
 
A special file type, with a .PGM extension, is used to store XLE/XLT application programs on 
microSD. 
 
To load an application from microSD to the XLE/XLT, use the Removable Media Manager to find 
and highlight the desired .PGM file, and then press Enter. 
 
To save an application from the XLE to microSD, open the Removable Media Manager in the 
System Menu and press the F4 function key. The application will be saved in a file called 
DEFAULT.PGM in the microSD root directory.  
 
To save an application from the XLT to microSD, open the Removable Media Manager in System 

Menu and press the Save Pgm  soft key displayed at the bottom of the XLT’s touch screen. 
The application will be saved in a file called DEFAULT.PGM in the microSD root directory.   
 

NOTE: Saving an application to microSD can only be done from the System Menu 
and is not available on a Removable Media Manager object that was 
placed on an application graphics screen by Cscape.  

 
NOTE: Saving an application to microSD does not also save register data.  

 
Cscape can also save an application directly to a microSD card, which is plugged into the PC’s 
microSD compatible card reader by selecting the Export to Removable Media item on the File 
menu. 
 
 
10.7 Using Removable Media to View and Capture Screens 
 
The XLE/XLT File System uses bitmap files with the .BMP (.bmp) extension to store XLE/XLT 
graphic screen captures. 
 
To view a captured XLE/XLT screen, use the Removable Media Manager to find and highlight 
the desired .BMP file, and then press Enter. 
 
To capture an XLE/XLT screen, turning on the assigned Screen Capture Control Register will 
capture the current XLE/XLT graphics screen and write it to the microSD card using the 
assigned Screen Capture Filename. 
 
Before capturing an XLE/XLT screen, Cscape must first be used to assign a Screen Capture 
Control Register and Filename in the application. To do this, first open the Graphics Editor by 
selecting the View / Edit Screens item on the Cscape Screens menu. Next, select the Screen 
Capture item of the Graphics Editor Config menu and then enter a Control Register and 
Filename. 
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10.8 Removable Media (RM) Function Blocks in Cscape 
 
NOTE: For detailed information regarding RM function blocks and parameters, refer to the 
Help File in Cscape Software. Refer to ‘USB Flash Media support for RM Functions’ for USB 
Flash drive access details. 
 
The following RM functional blocks are available in Cscape Software. These function blocks 
will reference: 
 

microSD when filename is prefixed with ‘A:’ or nothing 
OR 

USB A Flash Drive when filename is prefixed with ‘B:’ 
 

Read RM csv Allows reading of a comma-separated value file from the microSD 
interface into the controller register space. 

Write RM csv Allows writing of a comma-separated value file to the microSD 
interface from the controller register space. 

Rename RM csv Allows renaming a file on the RM card. The data in the file is not 
changed. 

Delete RM csv Allows deleting a file on the RM card 
Copy RM csv Allows copying a file on the RM card. The data in the file is not 

changed. 
Table 10.1 – RM Functional Blocks  

 
 
 
10.9 Removable Media (RM) Features—Program Features 
 
a. Datalog Configuration—This feature allows the controller to periodically log register values 
to Removable Media. The register data is stored in .csv (comma separated value) format, 
which is compatible with 3rd party PC applications, such as Microsoft Excel.  
 
b. Report Editor—This feature allows the OCS to be configured to generate text printouts 
which incorporate data from the registers embedded in the text. The reports can be printed 
using a serial interface printer through any of the serial ports of the OCS or can be saved on 
the removable media of the device.  
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10.10 Removable Media (RM) Features—Graphic/Screen Editor 
 
a. Trends—The historic support feature in the trend object utilizes Removable Media.  
 
b. Removable Media—This is a graphic object used to access files and functions pertaining to 
Removable Media. 
 
c. Recipes—This is a graphic object that is used in conjunction with the recipe editor which is 
mentioned above.  
 
 
10.11 Removable Media (RM) Features—Additional Configuration 
 
a. Alarms—Alarm data can be logged to a .csv file stored on Removable Media.  
 
b. Screen Capture—The screen capture function allows a bitmap or jpeg image of the displayed 
OCS screen to be written to the Removable Media card. 
  
c. Filename Counters— The filename counters can be accessed wherever Removable Media 
functions require a path name. A typical application is the auto-incrementing of a file name 
when doing screen captures. 
 
d. File Select— File Select is used to specify the register block that is used with the Removable 
Media Manager object ‘Write Selected Filename’ option. 
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10.12 Filenames used with the Removable Media (RM) Function Blocks 
 
The RM function blocks support the flash with a Windows standard FAT-16 file system. All names 
must be limited to the “8.3” format where the filename contains eight characters a period then 
a three-character extension. 
 
The entire filename including any path must be less than or equal to 147 characters. 
 
When creating filenames and directories, it is sometimes desirable to include parts of the 
current date or time. There are six special symbols that can be entered into a filename that are 
replaced by the OCS with current time and date information. 
 

Table 10.2 – Filename Special Symbols 
Symbol Description Example 

$Y Substitutes the current 2-digit year 2015 = 15 
$M Substitutes the current month with a 2-digit code March = 03 
$D Substitutes the current day 22nd = 22 
$h Substitutes the current hour in 24-hour format 5 pm = 17 
$m Substitutes the current minute 45 = 45 
$s Substitutes the current second 34 = 34 

 
NOTE: All the symbols start with the dollar sign ($) character. Date symbols are in upper case, 
time symbols are in lower case.  
 
The following are examples of the substituted time/date filenames: 
 
Current date and time: March 1, 2015 5:45:34 PM 
 
Filename: Data$M$D.csv = Data0301.csv 
 
Filename: Year$Y\Month$M\aa$D_$h.csv = Year15\Month03\aa01_17.csv 
 
Filename: Month_$M\Day_$D\$h_$m_$s.csv = Month_03\Day_01\17_45_34.csv 
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10.13 System Registers used with RM  
 

%SR174 – Removable Media Protect. Write a one (1) to %SR174 to prohibit read/write access to 
the removable media card. Write a zero (0) to allow access.   
 
%SR175 Status – This shows the current status of the RM interface.   
 
%SR176 Free Space – This 32-bit register shows the free space on the RM card in bytes. 
 
%SR178 Card Capacity – This 32-bit register shows the total card capacity in kilobytes. 
 
Possible status values are shown in the table: 
 

Table 10.3 – RM Status Values 
0 RM interface OK 
1 Card present but unknown format 
2 No card in slot 
3 Card present, but not supported 
4 Card swapped before operation was complete 
5 Unknown error 
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CHAPTER 11: GENERAL I/O 
 
NOTE: The datasheet is the first document to refer to for model-specific information related 
to XLE/XLT models such as pin-outs, jumper settings, and other key installation information.  
 
Visit the website to obtain datasheets, user documentation, and updates.   
North America          https://hornerautomation.com  
Europe                       http://www.horner-apg.com 
 
11.1 Overview 
 
The XLE/XLT is a compact unit that contains high density and very versatile I/O. Using the I/O 
properly requires wiring to the proper terminals, configuring jumpers inside the XLE/XLT unit 
and configuring Cscape properly. This section will offer some tips and suggestions to 
configure the I/O properly. For the register mapping of the I/O, refer to the Registers chapter 
for more details.  
 
11.2 Removing the XLE/XLT Back Cover  
 
 
 
 
 
Some I/O configurations require jumper settings to be changed inside the XLE/XLT unit. 
Examples of these settings are setting positive or negative logic on digital inputs or setting 
current or voltage on analog inputs. 
 
Each XLE/XLT I/O jumper is set to a factory default. Refer to the data sheet for your XLE/XLT 
model to find the default setting to determine if a jumper change is necessary for your 
application. 
 
To remove the back cover of the XLE/XLT, remove the four (4) Phillips screws from the back of 
the unit. It may help to place the XLE/XLT unit face down on a clean work surface. Once the 
four screws are removed the back cover can be lifted straight off. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11.1 – Removing the Back Cover 

WARNING: Power, including I/O power must be removed from the unit prior to removing 
the back cover. Failure to do so could result in electrocution and/or damage to equipment.  

https://hornerautomation.com/
http://www.horner-apg.com/
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Once the back is removed the jumper selection can be changed. The jumper settings are 
documented on each data sheet using a diagram such as Figure 11.2 below and a description of 
the jumper settings. 
 
 
 
 
 
 
 
 
 
 
 

Figure 11.2 – Example Jumper Diagram  
 
 
To re-install the back cover, place the cover back on the unit. The DIN clip should be on the same 
side as the power connector. 
 
Place the screw back into the hole and turn the screw slowly counter clockwise until it clicks 
into the threads. This prevents the screw from being cross-threaded. Now turn the screw clock-
wise until the cover is firmly secured. Repeat this process for all four (4) screws. Recommended 
torque is 3 - 4 in-lbs (0.34 – 0.45 Nm). 
 
 
11.3 Model and I/O Overview  
 

Table 11.2 – Built-In Digital & Analog I/O 
 Digital Analog 
 DC In DC Out 

(+) 
Relay 
Out 

HSC In* Pulse 
Out** 

mA/V 
In 

mA/V 
RTD/TC 

(Universal) 

mA/V 
Out 

Model 2 12 -- 6 4 -- 4 -- -- 
Model 3 12 12  4 2 2 -- -- 
Model 4 24 16 -- 4 2 2 -- -- 
Model 5 12 12 -- 4 2 2 2 
Model 6 12 12 -- 4 2 -- 6 4 

*Shared with total DC inputs 
**Shared with total DC outputs 

  

J1 J2

J3

JP3

JP1

001XLE005-R1

J4
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11.4 Solid-State Digital Outputs  
 
Solid-state digital outputs are generally used to activate lamps, low voltage solenoids, relays, 
and other low voltage and low current devices.   
 
NOTE: The digital outputs used on the XLE/XLT are “sourcing” outputs. This means the output 
applies a positive voltage to the output pin when turned ON. When turned off, the output applies 
approximately zero volts with respect to the I/O ground. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11.3 – Typical Output Wiring 
 
 
The digital outputs used in the XLE/XLT have electronic short circuit protection and current 
limiting. While these electronic protections work in most applications, some application may 
require external fusing on these outputs. 
 
The digital outputs in the XLE/XLT are typically controlled via %Q bits in the register mapping. 
Some of the outputs are designed for high-speed applications and can be used for PWM or 
frequency output applications. Please see the data sheet and the chapter on High Speed I/O for 
additional information. 
 
When the controller is stopped, the operation of each output is configurable. The outputs can 
hold the state they were in before the controller stopped or they can go to a predetermined 
state. By default, digital outputs turn off. For more information on Stop State, refer to the 
chapter on Cscape Configuration.  
 
The digital outputs feature an output fault bit. %I32 will turn on if any of the outputs experience 
a short circuit, over-current or the output driver overheats. 
 
  

Q14 

Q15 

V+ 

0V 

LOAD 

LOAD 

10 - 30VDC 

Q16 

 

LOAD 

J2 
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11.5 Relay Outputs  
 
Relay outputs are designed to switch loads that typically have high voltage or current 
requirements or require isolation that relays provide. 
 
NOTE: The design of the XLE/XLT does not require external coil power for the relays to function. 
The relays will activate anytime the XLE/XLT is powered. 
 
There are several factors that should be considered when using relays. 
 
Relay Life – Relays are mechanical devices that have a long but limited life. Typically switching 
more current limits the life of relays. Please check the data sheets at the end of this manual for 
expected relay life. 
 
Current / Temperature Derating – Products containing relays often have total current limits 
based on the ambient temperature of the application. Please see the product data sheet for 
current / temperature de-rating information for relays. 
 
Fusing – External fusing is generally required to protect the relays, devices and wiring from 
shorts or overloads.  
 
WARNING: To protect the module and associated wiring form load faults, use external (5A) 
fuses (as shown). Fuses of lower current or fusing for the entire system must be in place to 
ensure that the maximum current rating of the unit is NOT exceeded. 
 
WARNING: Connecting high voltage to any I/O pin can cause high voltage to appear at other I/O 
pins.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11.4 – Relay Fusing  
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Protection for Inductive Loads – Inductive loads can cause reverse currents when they turn off 
that can shorten the life of relay contacts. Some protective measures must be determined by 
an engineer. Below are some recommendations that will work for many applications. If there 
are additional questions on protection from inductive load, contact Technical Support. 
 
DC Loads – General purpose diode (IN4004) in reverse bias across the load. 
 
AC Load – MOV (Harris V140xxx for 120V, V275xx for 220V)  
 
Output State on Controller Stop 
 
When the controller is stopped the operation of each output is configurable. The outputs can 
hold the state they were in before the controller stopped or they can go to a predetermined 
state. By default, relay outputs turn off. For more information on stop state, Refer to the Cscape 
Configuration chapter.  
 
 
11.6 Digital Inputs  
 
NOTE: Refer to the High Speed I/O chapter for more information,  and refer to the datasheet 
for XLE/XLT model being used for details on jumper settings.  
 
NOTE: The digital inputs on the XLE/XLT are designed for low voltage DC inputs. The inputs are 
designed to support both positive and negative input modes. The mode is set by a jumper setting 
and a configuration parameter in Cscape. All the inputs on the unit must be configured to the 
same mode. 

 
Figure 11.5 – Positive and Negative Inputs 

 
In positive logic mode, a positive voltage applied to the input will turn the input ‘On’. The internal 
design of this mode is basically a resistor from the input to I/O ground. This mode is sometimes 
called sourcing. 
 
In negative logic mode, connecting the input to the I/O ground or zero volts will turn the input 
‘On’. The internal design of this mode is basically a resistor from the input to the positive I/O 
voltage (usually 12 or 24V). This mode is sometimes called sinking. Some of the digital inputs 
may support high speed input functional such as counting or frequency measurement.   
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11.7 Analog Inputs  
 
NOTE: See the datasheet for the XLE/XLT model being used for jumper settings, refer to the 
Cscape Configuration chapter for more details. 
 
The analog inputs on the XLE/XLT allow voltage or current measurement from a variety of 
devices. The voltage or current mode is set though jumpers on the unit and settings in Cscape. 
Each channel can be separately configured for voltage or current mode. 
 
The analog inputs have a digital filter that can be used to filter electrical noise that may be 
unavoidable in some installations. The downside to digital filtering is the inputs will respond 
more slowly to sudden changes in the actual input.    
 
 
11.7.1 Thermistor Option for Special Orders 
 
NOTE: The standard unit does NOT support thermistor. 
 
Thermistor support is a factory option for Models 2, 3, and 4 only. Model 2 can support a two-
channel and four-channel thermistor.  Models 3 & 4 support the two-channel thermistor only.  
Please refer to the Thermistor Supplement, SUP0797, for thermistor specifications and 
implementation details.   
 
 
11.7.2 Common Cause of Analog Input Tranzorb Failure, Models 2, 3, 4, & 5 
 
If a 4-20mA circuit is initially wired with loop power but without a load, the analog input could 
see 24VDC. This is higher than the rating of the tranzorb. 
 
This can be solved by not connecting loop power prior to load connection or by installing a low-
cost PTC in series between the load and the analog input. 
 

 
Figure 11.6 – Analog Input Tranzorb - Troubleshooting 
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11.8 Universal Analog Inputs  
 
NOTE: See the datasheet for the XLE/XLT model being used for jumper settings and the 
Cscape Configuration chapter for more details. 
 
The universal analog inputs provide a high resolution, very flexible interface for a variety of 
analog inputs. These inputs include voltage, current, thermocouple, RTD and millivolt. Each 
channel can be configured separately using jumpers (Model 5) or via the I/O connector (Model 
6) and configuration settings in Cscape. 
 
Like the standard analog inputs, these inputs have a digital filter that can be used to filter 
electrical noise that may be unavoidable in some installations. The downside to digital filtering 
is the inputs will respond more slowly to sudden changes in the actual input.  
 
The Universal Analog Inputs on the Model 6 I/O board are unique from other Horner XL-series 
input/output cards in that they are configurable through the module configuration instead of 
having to change jumper settings in order to setup the input type.  
 
To configure the Universal Analog input type: 

1. Select Analog In to access the Analog Input Configuration menu. 
2. Select any of the Analog input types from the dropdowns by clicking the down arrow 

beneath each corresponding Channel, as seen below: 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11.8 – Analog Input Configuration Screen 
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1) Ensure the proper wiring is used for each of the 3 pins A , B, and C on the Universal Analog 

Inputs as seen in the reference image below 

 

Figure 11.9 – Loop Power Requirements 
 
 
 
 
11.9 Analog Outputs  
 
NOTE:  Refer to the High Speed I/O chapter for more information and refer to the datasheet 
for XLE/XLT model being used for details on jumper settings.  
 
The analog outputs on XLE/XLT devices provide high-resolution voltage or current outputs. 
The voltage or current selection is controlled with jumpers and configuration settings in 
Cscape.  
 
NOTE: Each channel can be separately configured for voltage or current mode. 
 
When the controller is stopped, the operation of each output is configurable. The outputs can 
hold the state they were in before the controller stopped or they can go to a predetermined 
value. By default, analog outputs are set to a value of zero. For more information on Stop 
State, refer to the Cscape Configuration chapter for more details.  
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CHAPTER 12: HIGH SPEED I/O (HSC / PWM) 
 
 
12.1 Overview  
 
In addition to the compliment of simple analog and digital I/O, several of the XLE/XLT I/O 
modules support High Speed Counting (HSC) I/O functions and may also support Pulse Width 
Modulation (PWM) Output functions. The HSC functions include frequency, totalizing, pulse 
width, and quadrature measurement. The PWM functions include traditional PWM (with 
variable rate and duty) and a stepper (limited functionality) with variable acceleration and 
deceleration rates. To determine function availability, refer to the associated model’s 
Specification/Installation sheet (Digital DC Input/Output sections). 
 
This chapter describes the operation of these high level I/O functions. For configuration 
details of these functions, see Cscape Configuration.  
 
12.2 High Speed Counter (HSC) Functions 
 
On units that support the HSC, four dedicated inputs are available than can be configured for 
one of four modes of operation. Those modes are Frequency, Count (totalize), Pulse width or 
period (pulse) and Quadrature measurement. For some modes, more than one HSC input may 
be consumed. The measurement value is provided to ladder in a %AI register. Refer to HSC 
Function Register Map for more details.  
 
NOTE: While the high-speed input circuitry has a resolution of 1 μs, measured edge transitions 
must not occur faster than 100 μs for accurate measurements. Keep in mind that pulse width 
measurements utilize both the rising and falling edges of the waveform, thus the pulse width 
must exist longer than 100 μs. 

 
NOTE: The edge polarity selection in the mode parameter for the totalize and pulse width 
functions (Digital/HSC Input Configuration) assume Positive Logic regardless of the 
associated I/O board’s jumper setting for the Digital DC inputs polarity. If Negative logic is 
configured when using these functions, the opposite edge polarity must be selected in the 
mode parameter. 

 
 

12.2.1 Frequency  
 
In frequency mode, the frequency of the input signal is written to the accumulator in terms of 
Hertz (cycles/second). When using frequency mode, four update selections are provided 
which specify the width of the sample window. 
  
NOTE: Selecting a shorter sample window provides a quicker measurement (faster response) 
but lowers the frequency accuracy (resolution) and increases the minimum frequency 
measurement limit. 
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12.2.2 Totalize  
 
In totalize mode, the accumulator is simply incremented each time the input transitions in a 
specific direction. Totalize mode is configurable to specify the edge (rising or falling) on which 
the accumulator is incremented. 
 

 
 
Three different options are available to reset the current count. They are: 
  

• Configured reset value 
When configuring the Totalize function, a value may be specified under the Counts per 
Rev column. When the totalizer accumulator reaches this value - 1, the accumulator will 
reset to zero on the next count. Specifying zero for this value allows the totalizer to 
count through the full 32-bit range before resetting. 
 

• Ladder control  
Setting registers %Q17-20 reset HSC1-4 (respectively) with no additional configuration. 
When these registers are asserted, the associated totalizer accumulator is reset and 
held at zero (level sensitive).  

 
• Direct digital input control  (HSC1 and HSC2 only) 

HSC3 (%I11) and HSC4 (%I12) may be configured as hardware digital reset signals for 
HSC1 and HSC2 (respectively). To enable these inputs as reset signals, specify the type 
as Totalize Reset (NOTE: The corresponding Totalize HSC must be previously 
configured before this option is available). The direct digital reset controls are edge 
sensitive with the edge polarity configurable.   
 

Maximum direct digital reset latency is 100μs. 
 
The totalize function also supports an option which compares the current accumulator value 
with a supplied Preset Value (PV), which is provided through a %AQ, and drives a physical 
digital output based on the that comparison. 
 

• This option (available for HSC1 and HSC2 only) drives Q1 or Q2 output point 
(respectively) once the associated totalizer accumulator reaches (or exceeds) the PV 
value. To enable this function, the corresponding PWM function output (Q1 or Q2) must 
be configured for HSCx Output.    

 
NOTE: Q1 and Q2 are PWM function outputs that may be configured independently as one of 
the following: standard digital output, PWM, HSCx or stepper output.   
 
Preset values may be modified during run-time. A preset value of zero disables (resets) the 
totalizer compare function output causing the output to remain low.  

Rising Edge Signal Falling Edge Signal 
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12.2.3 Pulse  
 
In pulse mode, the high-speed input can measure the width or period of a pulse stream in one 
of four modes and provides a continuous indication of the last sampled value. 
 

Width High 1μs Counts – In this sub-mode the accumulator value will contain the number 
of 1μs counts the pulse is high. 
 

 
 
 
 
 
 
 

Width Low 1μs Counts - In this sub-mode the accumulator value will contain the number 
of 1μs counts the pulse is low. 

 
 
 
 
 
 
 

Period Rising Edges 1μs Counts – In this sub-mode the period of the input signal is 
reported in 1μs units. The period measurement will start on the rising edge of the input. 

 
 
 
 
 
 
 
 

Period Falling Edges 1μs Counts – In this sub-mode the period of the input signal is 
reported in 1μs units. The period measurement will start on the falling edge of the 
input. 

 
 
 
 
 
 
 
  

Width High 

Width Low 

Period from Rising Edge 

Period from Falling Edge 
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12.2.4 Quadrature  
 
Two HSC inputs are consumed for each of the two possible Quadrature counters. For example, 
selecting quadrature mode for HSC 1 will use HSC inputs 1 and 2, which correspond to A and B 
quadrature signals. Therefore, HSC 1 and 3 may be configured for quadrature input. 
Alternately, HSC 3 may be configured to reset HSC1 (quadrature) count on a marker input  
 
Quadrature mode works much like the totalizer except the accumulator will automatically 
increment or decrement based on the rotation phase of the two inputs. See the following 
example for more details. Quadrature inputs are typically used for reporting the value of an 
encoder. 
 
Two modes are available for quadrature that select whether the accumulator counts up or 
down when the phase of input 1 leads input 2. Check your encoder’s documentation to 
determine the output form it uses or try both modes to determine if the encoder counts up 
when expected.   
 

 
Using the above waveforms and a HSC input configuration of “Quadrature” - “1 leads 2, count 
up,” the accumulator will count up when 1 is rising and 2 is low, 1 is high and 2 is rising, 1 is 
falling and 2 is high, and when 1 is low and 2 is falling. This results in 4 counts per revolution. 
So in order to determine the number of cycles, the accumulator would have to be divided by 4.  
  

90°  

Phase shift 

1 (leading) 

2 (lagging) 
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Three different options are available to reset (or set) the current count.  
 

• Configured Counts per Rev value 
When configuring the quadrature function, a value may be specified under the Counts 
per Rev column. When rotation produces an increasing count, the quadrature 
accumulator resets to zero on reaching the Counts per Rev count. Alternately, when 
rotation produces a decreasing count, the quadrature accumulator is set to Counts per 
Rev – 1 on the count following zero. Specifying zero for this value allows the totalizer to 
count through the full 32-bit range before resetting.   
 
For example, if your encoder outputs 1024 counts per revolution, the value of 1024 can 
be entered into the configuration for Counts per rev. This will result in a counter that 
produces counts in the range of 0 to 1023.  
 

• Ladder control 
Setting registers %Q17 or Q19 resets quadrature (HSC) 1 or quadrature (HSC) 3 
(respectively) with no additional configuration. Setting registers %Q18 or Q20 sets 
quadrature (HSC) 1 or quadrature (HSC) 3 (respectively) to Counts per Rev – 1. 
 

• Direct digital input control (HSC3) [Marker] 
When HSC input 1 and 2 are used for quadrature inputs, an additional choice of marker 
input becomes available for HSC input 3. The marker input is typically part of an 
encoder or motion system that signals when a cycle of motion is complete. When the 
marker input is triggered, the accumulator is reset to zero or to Counts per rev - 1 
based on rotation direction. 
 
Marker reset operation is enabled when HSC3 is configured for Marker type. Once 
selected, one of several modes is available for marker operation. These modes can be 
sub-divided into two groups of marker operation. 
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Asynchronous modes ignore the quadrature inputs and reset the quadrature accumulator to 
zero on the configured edge (rising, falling or both). These are the most common settings 
used. When configuring, asynchronous mode selections are prefixed with the word Async.  

 
Synchronous modes synchronize the reset (or set) to the selected quadrature input and the 
selected marker polarity. Figure 11.1 below indicates which mode to select based on the 
markers timing diagram. Consult the documentation provided with your encoder to determine 
the marker pulse timing. 
 
NOTE: The Marker input is sampled within 50μs of the associated quadrature edge. It is left to 
the user to determine if this meets the time constraints of the measured drive. 

 
NOTE: If the Marker input pulse consecutively spans more than one of the specified edges, 
quadrature-decoding operation is unpredictable. 
 
 
 
 Sync mode selection   Waveforms (Clockwise Rotation            ) 
 __________________________________________________________________ 
 
     [1] 
 
 
     [2]  
      
 
 High, Reset on 2 rising      [SYNC]   
 
 
 High, Reset on 1 falling        [SYNC] 
 
 
 High, Reset on 2 falling       [SYNC] 
 
 
 High, Reset on 1 rising         [SYNC] 
  
 

*While not displayed in this figure, modes for low level (inverse logic) are also supported 
for each state.  
 

Figure 12.1 – Sync pulse mode illustration 
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The accumulator is reset to zero on the specified edge if rotation is clockwise (as shown in 
Figure 12.1 above). However, if rotation is reversed, the accumulator is alternately set to 
Counts per rev – 1 on that same physical edge. When direction is reversed, that same physical 
edge is seen (by the internal decoder) as having the opposite edge polarity as shown below. 
 

Table 12.1 – Sync Pulse Mode 

Mode Direction A (HSC1) B (HSC2) 
Marker 
(HSC3) 

Reset 
Value 

Async, Reset on rising edge    Rising 0 
Async, Reset on falling edge    Falling 0 
Async, Reset on both edge    Both 0 

High, Reset on 1 rising Clockwise Rising  High 0 
“ Counter Falling  High CPR - 1 

Low, Reset on 1 rising Clockwise Rising  Low 0 
“ Counter Falling  Low CPR - 1 

High, Reset on 1 falling Clockwise Rising  High CPR - 1 
“ Counter Falling  High 0 

Low, Reset on 1 falling Clockwise Rising  Low CPR - 1 
“ Counter Falling  Low 0 

High, Reset on 2 rising Clockwise  Rising High 0 
“ Counter  Falling High CPR - 1 

Low, Reset on 2 rising Clockwise  Rising Low 0 
“ Counter  Falling Low CPR - 1 

High, Reset on 2 falling Clockwise  Rising High CPR - 1 
“ Counter  Falling High 0 

Low, Reset on 2 falling Clockwise  Rising Low CPR - 1 
“ Counter  Falling Low 0 

 
 
12.3 HSC Functions Register Map 
 

Table 12.2 – HSC Functions Register Map 
Register Frequency Totalize Pulse Quad 
%AI5-6 HSC1 (function) Accumulator Quad 1 Acc 
%AI7-8 HSC2 (function) Accumulator  
%AI9-10 HSC3 (function) Accumulator Quad 2 Acc 
%AI11-12 HSC4 (function) Accumulator  
%AQ1-2 

 
HSC1 Preset 

  
%AQ3-4 HSC2 Preset 

%Q17 

 

Clear HSC1 

 

Clear Quad 1 
%Q18 Clear HSC2 Set Quad 1 
%Q19 Clear HSC3 Clear Quad 2 
%Q20 Clear HSC4 Set Quad 2 
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12.4 Pulse Width Modulation (PWM) Functions  
 
On units that support the PWM, two dedicated outputs are available that can be configured for 
one of four modes of operation. Those modes are Normal, PWM, HSC (count = PV) and 
Stepper.  
 
12.4.1 Normal  
 
When either Q1 or Q2 is configured for Normal operation, the digital output registers %Q1 and 
%Q2 drives that respective output. 
 
12.4.2 PWM 
 
When either Q1 or Q2 is configured for PWM, the PWM function drives that respective output. 
Both PWM channels may be individually enabled; however, when both PWM outputs are 
enabled, both share the same output frequency (with the low going pulses synchronized). 
Otherwise, each PWM’s pulse width can be independently adjusted. 
 
The PWMs require three parameters (%AQs) to be set for operation. These parameters may 
be set at run-time. The register set and prescale calculation differ depending upon the 
XLE/XLT hardware being used, hardware revs A-R use the following resisters and scaling: 
 

• Prescale Count (Revision A-R) 
The prescale (%AQ5-6) count sets the resolution of the internal counter used for 
generating the PWM output. The (prescale count + 1) is a divisor applied to a 16MHz clock 
that drives the internal PWM counter. For the highest resolution PWM output, this value 
should be set as low as possible (0 provides a 1/16 micro second resolution). Both the 
Period and Duty cycle (pulse width) are based on counts of the internal PWM counter. 

 
The frequency of the PWM output is calculated using the following formula: 

 

Frequency = ( ) tPeriodCountescaleCoun +1Pr

000,000,16
 

 
• Pre-scale Count Revision T and onwards 

The pre-scale %AQ5 (PWM1) or %AQ6 (PWM2) count sets the resolution of the internal 
counter used for generating the PWM output. The (pre-scale count + 1) is a divisor 
applied to a 32MHz clock that drives the internal PWM counter. For the highest 
resolution PWM output, this value should be set as low as possible (0 provides a 1/32 
micro second resolution). Both the Period and Duty cycle (pulse width) are based on 
counts of the internal PWM counter. 

 
The frequency of the PWM output is calculated using the following formula: 

 

Frequency = ( ) tPeriodCountescaleCoun +1Pr

000,000,32

 

  



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  90 | 168 
 

• Period Count 
This value (%AQ7-8) sets the period of the output signal by specifying the number of 
internal PWM counter counts before the cycle is reset (larger count results in a smaller 
frequency). The duration of each count is determined by the pre-scaler value. This 
parameter affects the Period of both PWM outputs. 

 
See the previous formula to see how the pre-scale and period counts create an output 
frequency. For example, setting the PWM for 1μs resolution (pre-scale=15), and a period 
count of 20,000 would result in a 50Hz output. 

 

 
• Duty Cycle Count 

This value (PWM1: %AQ1-2, PWM2: %AQ3-4) sets the width of the output signal by 
specifying the number of internal PWM counter counts that the output is maintained 
high. The duration of each count is determined by the pre-scaler value. Each PWM 
channel has its own duty cycle count parameter. 
 
Setting the period count to 1000 and the duty cycle count to 500 results in a duty cycle 
of 50 percent. Changing just the duty cycle count to a value of 250 results in a duty 
cycle of 25%. 

 
  

Period 

Duty Cycle 
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At controller power-up or during a download, the PWM output is maintained at zero until 
both the Period (count) and the Duty cycle (count) are loaded with non-zero values. 
When the controller is placed in stop mode, the state of the PWM outputs is dependent 
on the PWM State on Controller Stop configuration. This configuration allows for either 
hold-last-state or specific prescale, period and duty cycle counts. Specifying zero for 
either the period or duty causes the PWM output to remain low during stop mode. 
 
NOTE: The nominal output driver turn-on-time delay (to reach 50% output) is 25μs on 
Models 3-5. Therefore, this limitation should be considered when determining both the 
minimum pulse width and the duty cycle accuracy of the application. 

 
 
The following table shows the PWM registers used for the old and new revisions: 
 

Table 12.3 – PWM Old and New Registers 
PWM Old Registers PWM New Registers 

AQ1 – PWM1 Duty Cycle(DWord) AQ1 – PWM1 Duty Cycle 
 AQ2 – Reserved 

AQ3 – PWM2 Duty Cycle(DWord) AQ3 – PWM2 Duty Cycle 
 AQ4 – Reserved 

AQ5 – Pre-Scale(DWord) AQ5 – PWM1 Pre-Scale 
 AQ6 – PWM2 Pre-Scale 

AQ7 – Period(DWord) AQ7 – PWM1 Period 
 AQ8 – PWM2 Period 

 
1) When an old XLE/XLT file is auto configured to a new XLE/XLEe or XLT/XLTe file, then 

the old formula and registers are taken and firmware will do the required adjustments 
for the PWM to function normally. 

 
2) When a new XLE/XLT file is created, then the new formula will be applied and the 

configuration must be as per the new register set. 
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12.4.3 PWM Output Waveform 

 
 

Figure 12.2 – PWM Output Waveform  
 
 
 

Table 12.4 – PWM Output Waveform Table 
Rise Time 150ns Max 
Fall Time 150ns Max 
PWM Period Frequency = 

1

𝑃𝑒𝑟𝑖𝑜𝑑
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12.4.5 Stepper Function 
 
When Q1 is configured for Stepper, the stepper function is enabled at the Q1 output. Only one 
stepper function and output is available. 
 
NOTE: When Q1 is configured for stepper operation, Q2 operation is limited to direct digital 
output.  
 
The Stepper requires five parameters (%AQs) to be set for operation. These parameters may 
be set at run-time but are ‘latched’ when the stepper is commanded to start. 
 
Start Frequency (cycles per second) 

This value (%AQ1) sets the frequency for the first cycle during the acceleration phase 
and the frequency of the last cycle during the deceleration phase. When an acceleration 
or deceleration count is specified, the Start Frequency must be greater than zero (0) 
and must not exceed the run frequency or an error is generated. 

 
Run Frequency (cycles per second) 

This value (%AQ2) sets the frequency for the last cycle during the acceleration phase, 
the consistent frequency during the run phase, and the frequency of the first cycle 
during the deceleration mode. The Run Frequency must be greater than zero (0) and 
must not exceed 5000 cycles/sec. or an error is generated. 

 
Acceleration Count  

This value (%AQ3-4) sets the number of cycles to occur within the acceleration phase. 
The frequency of the cycles within this mode will vary linearly between the specified 
Start and Run frequency. The Accel count must not equal 1 or an error is generated. 
Setting this value to zero (0) disables this phase. 

 
Run Count  

This value (%AQ5-6) sets the number of cycles to occur within the run phase. The 
frequency of the cycles within this mode is constant at the specified Run frequency. The 
Run count may be any value. Setting this value to zero disables this phase. 

 
Deceleration Count  

This value (%AQ7-8) sets the number of cycles to occur within the deceleration phase. 
The frequency of the cycles within this phase will vary linearly between the specified 
Run and Stop frequency. The Decel count must not equal 1 or an error is generated. 
Setting this value to zero disables this phase. 
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The stepper provides two Boolean registers to provide stepper status 
 
Ready/Done  

A high indication on this register (%I30) indicates the stepper sequence can be started 
(i.e. not currently busy). 
 

Error  
A high indication on this register (%I31) indicates that one of the analog parameters 
specified above is invalid or the stepper action was aborted before the operation was 
complete. This register is cleared on the next start command if the error was 
corrected. 

 
The stepper requires one discrete register (%Q1) to control the stepper action. Setting this 
register starts the stepper cycle. This register must remain set to complete the entire cycle. 
Clearing this register before the cycle is complete aborts the step sequence and sets the error 
bit. 
 
NOTE: Setting the PLC mode to Stop while the stepper is in operation causes the stepper 
output to immediately drop to zero and the current stepper count to be lost. 

 
NOTE: Stepper output level may cause damage or be incompatible with some motor driver 
inputs. Consult drive documentation to determine if output level and type is compatible. 
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12.5 HSC Output    
 

When using I/O models equipped with solid-state outputs, the first two outputs may be used in 
conjunction with the first two High-Speed Counter inputs when those inputs are set to 
‘Totalize’. When the HSC accumulator matches or exceeds the preset value, these 
configuration options allow the output to turn ON, turn OFF, toggle, or pulse for a configurable 
amount of time.  
 

  
 

Functionality: 
The HSC Outputs function by comparing an HSC Input accumulator to its configured Preset 
value. With the Output Pulse option, a Pulse Time value is configured to determine the ON 
time. The location of these values may be found in the HSC function register map. 
 
OUTPUT ON: 
When the HSC accumulator becomes greater than or equal to the Preset value, the output will 
turn ON. Otherwise, it is turned OFF.  
 
OUTPUT OFF: 
When the HSC accumulator becomes greater than or equal to the Preset value, the output will 
turn OFF. Otherwise, it is turned ON.  
 
OUTPUT TOGGLE: 
When the HSC accumulator becomes equal to the Preset value, the output will toggle, either 
from OFF to ON, or from ON to OFF.  
 
OUTPUT PULSE: 
When the HSC accumulator becomes equal to the Preset value, the output will turn ON and 
remain ON until the configured pulse time expires, then turn OFF. If another match occurs 
during the countdown to turn the output off, the pulse countdown restarts and the output 
remains ON until the countdown is complete. 
 
NOTE:  The output pulse time resolution is 50μ. 
 
NOTE: The state of outputs %Q1 and %Q2 are not reflected in their respective registers when 
selected for operation other than ‘Normal’ 
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Example 1: 

Turn HSC1 Output ON if HSC accumulator 1 exceeds a count of 100,000. 

Assuming HSC #1 is already configured to ‘Totalize’: 

- Select ‘HSC1 Output’ and the ‘Output ON’ option 

- Load UDINT value of 100,000 into %AQ1-2 HSC1 Preset value  

- Download the program and input pulses to HSC #1 

- Observe UDINT %AI5-6 HSC1 Accumulator value for the accumulated count. 

- When %AI5-6 HSC1 Accumulator reaches and exceeds the Preset value, the output Q1 will turn 
ON. 

- The output Q1 will remain on until HSC1 is cleared with the %Q17 bit. 

Example 2: 

Pulse the Q2 Output for 100 milliseconds when HSC accumulator 2 matches the value of 
50,000. 

Assuming HSC #2 is already configured to ‘Totalize’: 

- Select ‘HSC2 Output’ and the ‘Output Pulse’ option 

- Load UDINT value of 50,000 into %AQ3-4 HSC2 Preset value 

- Load UDINT value of 100,000 into %AQ27-28 Pulse Time 

- Download the program and input pulses to HSC #2 

- When %AI7-8 HSC2 Accumulator becomes equal to 50,000, the output Q2 will turn ON for 100 
milliseconds and then turn OFF. 

 
 

12.6 PWM functions register map 
 

Table 12.5 – PWM Function Registers Map  
Register PWM HSC Stepper 

%AQ1 PWM1 Duty Cycle (32-
bit) 

HSC1 
Preset Value 

Start Frequency 
%AQ2 Run Frequency 
%AQ3 PWM2 Duty Cycle (32-

bit) 
HSC2 

Preset Value 
Accel Count 

(32-bit) %AQ4 
%AQ5 PWM Prescale 

(32-bit) 
 

Run Count 
(32-bit) %AQ6 

%AQ7 PWM Period 
(32-bit) 

 
Decel Count 

(32-bit) %AQ8 
%Q1   Run 
%I30 

  
Ready/Done 

%I31 Error 
 
 
When either Q1 or Q2 is configured for HSC operation, HSC1 or HSC2 totalize functions are 
extended to allow respective direct output control based on a comparison of the current 
count and a preset value (PV). See totalize in the HSC section above for more information. 
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12.7 PWM Examples  
 
All of the PWM examples use the following formula. 
 

Frequency = ( ) tPeriodCounescale +1Pr

000,000,32

 

 
Example 1 
To get a 50% Duty Cycle @ 10 kHz waveform on PWM1: 
 
Set %AQ1 = 50 (duty cycle count) 
Set %AQ5 = 30 (prescale count) 
Set %AQ7 = 100 (period count) 
 
 
Example 2 
To get a 50% Duty Cycle on PW1 and 90 % Duty Cycle on PWM2 @ 1 kHz waveform: 
 
Set %AQ1 = 500 (duty cycle count) 
Set %AQ3 = 900 (duty cycle count) 
Set %AQ5-6 = 30 (prescale count) 
Set %AQ7-8 = 1000 (period count) 
 
Example 3 
To turn PWM 1 output ON all the time 
 
Set %AQ1-2 = Same value as AQ7-8 (duty cycle count) 
Set %AQ5-6 = Any value (prescale count) 
Set %AQ7-8 = Non-Zero value (period count) 
 
Example 4 
To turn PWM 1 output OFF all the time 
 
Set %AQ1-2 = 0 (duty cycle count) 
Set %AQ5-6 = Any value (prescale count) 
Set %AQ7-8 = Any value <or> 0 (period count) 
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12.8 STP Examples  
 
Example 1 
10,000,000 steps control sequence 

The following example starts at 2.5kHz and ramps up to 5kHz during the first 1,000,000 
steps. Then, it runs at 5kHz for the next 8,000,000 steps. Finally, during the last 1,000,000 
steps it slows to a stop. 

 
Set %AQ1 = 2500 (Hz)  {Start Frequency} 
Set %AQ2 = 5000 (Hz)  {Run Frequency} 
Set %AQ3-4 = 1000000 (Steps)  {Accel Count} 
Set %AQ5-6 = 8000000 (Steps) {Run Count} 
Set %AQ7-8 = 1000000 (Steps) {Decel Count} 
 
Example 2 
5,000,000 steps control sequence 

The following example starts at 0.5kHz and ramps up to 1kHz during the first 2,000,000 
steps. Then, it runs at 1kHz for the next 2,000,000 steps. Finally, during the last 1,000,000 
steps it slows to a stop. 

 
Set %AQ1 = 500 (Hz)   {Start Frequency} 
Set %AQ2 = 1000 (Hz)   {Run Frequency} 
Set %AQ3-4 = 2000000 (Steps)  {Accel Count} 
Set %AQ5-6 = 2000000 (Steps)  {Run Count} 
Set %AQ7-8 = 1000000 (Steps)  {Decel Count} 
 
Example 3 
6,000,000 steps control sequence 

The following example starts at 50Hz and ramps up to 250Hz during the first 150,000 
steps. Then, it runs at 250Hz for the next 5,500,000 steps. Finally, during the last 350,000 
steps it slows to a stop. 

 
Set %AQ1 = 50 (Hz)    {Start Frequency} 
Set %AQ2 = 250 (Hz)   {Run Frequency} 
Set %AQ3-4 = 150000 (Steps)  {Accel Count} 
Set %AQ5-6 = 5500000 (Steps)  {Run Count} 
Set %AQ7-8 = 350000 (Steps)  {Decel Count} 
 
 
NOTE: The highest usable frequency is 65kHz for the PWM output. This is only achievable on a 
Model 6 unit, Models 2-5 max output frequency is approximately 10kHz. 
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CHAPTER 13:  USER INTERFACE 
 
13.1 Overview 
 
This chapter presents the user interface (or operator view) of the XLE/XLT and some of the 
model specific characteristics of the XLE/XLT as compared to the rest of the OCS line. This 
chapter does NOT cover building screens or using the CSCAPE Graphics Editor. For instructions 
on creating screens and using the graphics editor, refer to the Graphics Editor Help file in 
CSCAPE. 
 
13.2 Screen Navigation 
 
The screen navigation on the XLE/XLT is quite flexible. Basic methods will be described here.  
Control programming can be used to create complex screen navigation techniques. 
 
One form of screen navigation is the Jump Screen graphics object. This object is typically tied 
to a soft key (One of the four keys to the sides of the display for the XLE and at the bottom of 
the screen for the XLT). Pressing the soft key will switch to the screen that is programmed. 
 
 
 
 
 
 
 
 
 
 

Figure 13.1 – Typical Screen Jump Object (XLE) 
 
 
 
 
 
 
 
 
 
 
 

Figure 13.2– Typical Screen Jump Object (XLT) 
 

Screen jumps can also be triggered on other keys or based on control logic for more advanced 
applications. To allow the operator to change screens, a screen jump object is generally used.  
This object may be visually represented as a button (responding to touch) or remain invisible 
and logically tied to an OCS register. An optional system ICON may be configured for display 
along with the legend, which aids in identifying the object as one that causes a screen change. 
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13.3 Using Editable Screen Objects  
 
When a screen contains editable objects, one of the objects will be selected by default. Selected 
objects will be outlined with a dotted line. The arrow keys can be used to navigate the editable 
objects and allow selection of an object to edit. When the object to be edited is selected press 
the Enter button. This enters the objects editing mode. 
 
The most common editable object is the numeric object.  
 
XLE Specific: 
 

 
 
XLT Specific: 

 
 
The value chosen by the operator cannot exceed the minimum or maximum set by the user 
program. If the user tries to exceed the maximum point or enter a value below the minimum 
point, the value will not change.  
  
NOTE: If the XLE/XLT displays >>>>>> in a numeric field, the value is too big to display in the field 
or is above the maximum for an editable field. If the XLE/XLT displays <<<<<< in a numeric field, 
the value is too small to display or is below the minimum for an editable field.   
 
 
 
 
  

When in edit mode, a cursor appears on one digit of the editable field. Use the direction keys 
 and  to move the cursor to the desired position. Use the  and  keys to increment or 
decrement the digit or enter the number/data with the alphanumeric keys. 

The most common editable object is the numeric object. To edit, touch the object and the pop-
up keypad will appear to allow editing of the value.  
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13.4 Ladder Based Screen Navigation  
 
Ladder logic can use several techniques to control screen navigation. Coils can be tied to %D 
registers to make them screen coils. These coils have two modes: switch and alarm. If the 
ladder program energizes an alarm display coil, the screen associated with this coil is 
displayed and overrides the normal user screens. This is designed to show alarm conditions or 
to display other ladder-detected events. When the text coil is de-energized, the previous 
screen that was being viewed before the alarm is returned.  
 
The switch display coil switches to the associated screen when it is energized. Once it is de-
energized the screen remains until it is switched by the user or ladder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 13.3 – Force and Switch Coils in Ladder Programming in Cscape 
 

 
There is also a system register that can be used to for control based screen navigation. %SR1 
can be read to determine the current screen or written to change the current screen.   
 
Refer to the Online Help in Cscape for more information on control-based screen navigation. 
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13.5 Alarms 
 
Alarm presentation to the operator is highly configurable and beyond the scope of this 
document to describe fully. The alarm object is generally used to enunciate alarms to the 
operator.  
 
For more information, refer to the Graphics Editor Help File in Cscape. This section presents a 
typical configuration thereby providing an introductory description on what the operator 
should expect.  
 
To open the Alarm Configuration dialog, click on the Graphics Editor icon in the menu tool bar.   
 
 

 
 
Then select Config → Alarm from the tool menu bar to open the Alarm Configuration dialog.  
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Figure 13.4—Alarm Configuration in Cscape 

 
To view, acknowledge, and/or clear alarms, the operator must access the alarm viewer. This is 
accomplished by selecting an alarm object. When accessed, the alarm object is displayed as 
pop-up alarm viewer dialog similar to that shown in Figure 13.5. If more entries exist than can 
fit on the page, a scroll bar is displayed on the right side that also indicates the current 
relative position.   
 

 
Figure 13.5 – Alarm Object 

 
   
Once view operations are complete, simply touch the Esc button to remove the pop-up alarm 
viewer. 
 
NOTE: OCS registers %SR181 and %SR182 are available for ladder use, which indicate 
presence of unacknowledged or acknowledged alarm (respectively). The screen designer may 
implement these registers to switch screens or activate the beeper to attract the operator’s 
attention. 
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13.6 Screen Saver 
 
The XLE/XLT screen backlight life remains sufficiently bright for five (5) years. It will dim to 
70% brightness if it is left on continuously for five (5) years. If the application does not 
require interaction with the OCS for long periods of time, the backlight life can be extended by 
using the screen saver function. When enabled through the System Menu, the backlight is shut 
off (screen goes black) after a specified time of no activity on the screen. When the screen 
saver shuts off the backlight, any key or button reactivates the backlight.   
 
It is possible for the application to temporarily disable the screen saver by generating a 
positive transition to %SR57.16 (coil only) at a rate faster than the screen saver timeout 
value. This may be desired while waiting for alarm acknowledgement. 
 
NOTE: The backlight life can be extended by dimming or powering off the backlight.  
 
 
13.7 Screen Brightness 
 
The XLT provides a feature that allows screen dimming for night operation. To enable this 
feature, the application must access and control system register %SR57 (Display Backlight 
Brightness). Screen brightness is continuously variable by driving %SR57 through the range 
of 100 (full bright) to 0 (full off). It is left to the screen designer on if and how to present a 
Screen Brightness control to the user. 
 
 
NOTE: Only the XLT offers a screen dimming function. 
 
NOTE: The backlight life can be extended by dimming or powering off the backlight.  
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CHAPTER 14:  REGISTERS 
 
 
14.1 Register Definitions 
 
When programming the XLE/XLT, data is stored in memory that is segmented into different 
types. This memory in the controller is referred to as registers. Different groups of registers 
are defined as either bits or words (16 bits). Multiple registers can usually be used to handle 
larger storage requirements. For example, 16 single bit registers can be used to store a Word 
or two 16-bit registers can be used to store a 32-bit value.   
 
Below is a list of the type of registers found in the XLE/XLT. 
 
%AI Analog Input  
16-bit input registers used to gather analog input data such as voltages, temperatures, and 
speed settings coming from an attached device.  
 
%AQ Analog Output  
16-bit output registers used to send analog information such a voltages, levels or speed 
settings to an attached device.  
 
%AIG Global Analog Input  
Specially defined 16-bit input registers that come from the network.  
 
%AQG Global Analog Output  
Specially defined 16-bit output registers that go to the network.  
 
%D Display Bit  
These are digital flags used to control the displaying of screens on a unit which has the ability 
to display a screen. If the bit is SET, the screen is displayed.   
 
%I Digital Input  
Single-bit input registers. Typically, an external switch is connected to the registers.  
 
%IG Global Digital Input  
Specially defined single-bit inputs that come from the network.  
 
%K Key Bit  
Single-bit flags used to give the programmer direct access to any front panel keys appearing 
on a unit.  
 
%M Retentive Bit  
Retentive single-bit registers.  
 
%Q Digital Output  
Single-bit output registers. Typically, these bits are connected to an actuator, indicator light 
or other physical outputs.  
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%QG Global Digital Output  
Specially defined single-bit outputs that go to the network.  
 
%R General Purpose Register  
Retentive 16-bit registers.  
 
%S System Bit  
Single-bit bit coils predefined for system use.  
 
%SR System Register  
16-bit registers predefined for system use.  
 
%T Temporary Bit  
Non-retentive single-bit registers.  
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14.2 Useful %S and %SR registers  
 

Table 14.1 – Common %S Register Definitions 
Register Name Description 

%S1 FST_SCN Indicate First Scan 
%S2 NET_OK Network is OK 
%S3 T_10MS 10mS timebase 
%S4 T_100MS 100mS timebase 
%S5 T_1SEC 1 second timebase 
%S6 IO_OK I/O is OK 
%S7 ALW_ON Always ON 
%S8 ALW_OFF Always OFF 
%S9 PAUSING_SCN Pause 'n Load soon 
%S10 RESUMED_SCN Pause 'n load done 
%S11 FORCE I/O being forced 
%S12 FORCE_EN Forcing is enabled 
%S13 NET_IO_OK Network I/O is OK 

 
 

Table 14.3 – %SR Registers – Master %SR Table  

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR1 USER_SCR 
User Screen Number  
*Excludes RCC Units   

0 to 1023 Read/Write Read/Write 

%SR2 ALRM_SCR 
Alarm Screen Number (0=none) 
*Excludes RCC Units   

0 to 1023 Read Only Read Only 

%SR3 SYS_SCR 

System Screen Number  
1 = Main System Menu 
2= Set Network ID, Network Status, 
(%SR29) 
3= Set Network Baud (%SR30) 
4= Set Contrast (%SR32) 
5= View OCS Status 
6= View OCS Diagnostics 
7= View I/O Slots 
8= Set Function Key Mode (%SR33) 
9= Set Serial Ports (%SR34) 
10= Set Time/Date (%SR44-%SR50) 
11= Set Beeper (%SR183) 
12= Set Screen (%SR185) 
13= Removable Media 
14= View Protocols 
15= IP Address (ETN I/O Board) 
16= Fail Safe System 
17= Backup / Restore Data 
18= Enable AutoRun 
19= Enable AutoLoad 
20= Clone Unit -  
21= Touch Calibration 
24= License Details 
*Excludes RCC Units  

0 to 24 
 

Read/Write Read/Write 

%SR4 SELF_TST Self-Test Results   Read Only Read Only 
%SR4.1  Self-Test Results – BIOS Error  Read Only Read Only 
%SR4.2  Self-Test Results – Engine Error  Read Only Read Only 
%SR4.3  Self-Test Results – Ladder Error  Read Only Read Only 
%SR4.4  Self-Test Results – RAM Error  Read Only Read Only 
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Table 14.3 – %SR Registers – Master %SR Table  

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 
%SR4.5  Self-Test Results – Duplicate ID Error  Read Only Read Only 
%SR4.6  Self-Test Results – Bad ID Error  Read Only Read Only 

%SR4.7 
 Self-Test Results – I/O Configuration 

Error 
 Read Only Read Only 

%SR4.8  Self-Test Results – Bad Network Error   Read Only Read Only 
%SR4.9  Self-Test Results – Bad Logic Error  Read Only Read Only 
%SR4.10  Self-Test Results – Bad Clock Error  Read Only Read Only 
%SR4.11  Self-Test Results – DeviceNet Error  Read Only Read Only 
%SR4.12-.16 Reserved     

%SR5 CS_MODE 

Control Station Mode  
0= Idle 
1= Do I/O 
2= Run 
3= Online Change 
*Supported in Linux and XL+ units only  

0 to 3 
 

Read Only Read/Write 

%SR6  Average Scan Rate ms ( / 10)  Read Only Read Only 
%SR7  Minimum Scan Rate ms ( / 10)  Read Only Read Only 
%SR8  Maximum Scan Rate ms ( / 10)  Read Only Read Only 
%SR9 TCH_PRESSURE Current Touch Pressure  0 to 3000 Read Only Read Only 

%SR10 
TCH_PRESSURE
_TSH 

Threshold Touch Pressure 0 to 3000 
 

Read/Write 
 

Read/Write 

%SR11-12  Ladder Size (32-Bit DINT)  Read Only Read Only 

%SR13-14   
User Text Screen Size (32-Bit DINT) 
*Excludes RCC Units   

 Read Only Read Only 

%SR15-16  
System Text Screen Size (32-Bit DINT) 
*Excludes RCC Units   

 Read Only Read Only 

%SR17-18  
I/O Configuration Table Size (32-Bit 
DINT) 

 Read Only Read Only 

%SR19-20  Network Config Table Size (32-Bit DINT)   Read Only Read Only 
%SR21-22  Security Data Table Size (32-Bit DINT)   Read Only Read Only 
%SR23  Ladder Code CRC  Read Only Read Only 
%SR24  User Text CRC  Read Only Read Only 
%SR25  System Text CRC  Read Only Read Only 
%SR26  I/O Configuration Table CRC  Read Only Read Only 
%SR27  Network Configuration Table CRC  Read Only Read Only 
%SR28  Security Data Table CRC  Read Only Read Only 

%SR29 NET_ID 

Network ID   

Read Only Read / Write 
CsCAN Mode 1 to 253 
DeviceNet Mode 0 to 63 
CANOpen Mode 1 to 127 

%SR30  

Network Baud Rate 
0=125KB 
1= 250kB 
2= 5000KB 
3= 1MB 
4=50K 

0 to 4 
 

Read Only Read/Write 

%SR31  

Network Required  
0= Network not required 
1= Network required; 
2= Network optimized; 
3= Network required and optimized 

0 to 3 Read Only Read Only 

%SR32  
LCD Display Contrast setting 
*Excludes RCC Units  

0 to 255 Read Only Read/Write 
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Table 14.3 – %SR Registers – Master %SR Table  

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR33  

Function Key Toggle Mode  
0= Momentary 
1= Toggle 
*Excludes RCC Units    

0 to 1 
 

Read/Write 
Read/Write 

 

%SR34  

RS232 Serial Protocol Mode 
0= Firmware Update (RISM) 
1= CsCAN 
2= Generic (Ladder- Controlled) 
3= Modbus RTU 
4= Modbus ASCII 

 

 
 
 

Read Only 
 

Read Only 

%SR35-36  

Unique Serial Number /  
Hexadecimal LAN1 MAC ID  

 
 

 Read Only Read Only 

%SR37  Model Number  Read Only Read Only 

%SR38  Engine Version ( /100)  Read Only Read Only 
%SR39  BIOS Rev Number  ( / 100)  Read Only Read Only 
%SR40  FPGA Image Rev Number ( / 10)  Read Only Read Only 

%SR41  
Vertical Pixel Count 
*Excludes RCC Units  

 Read Only Read Only 

%SR42  
Horizontal Pixel Count 
*Excludes RCC Units  

 Read Only Read Only 

%SR43  Keypad Type 
*Excludes RCC Units  

 Read Only Read Only 

%SR44 RTC_SEC Real-Time-Clock Second 0 to 59 Read Only Read Only 
%SR45 RTC_MIN Real-Time-Clock Minute 0 to 59 Read Only Read Only 
%SR46 RTC_HOUR Real-Time-Clock Hour 0 to 23 Read Only Read Only 
%SR47 RTC_DATE Real-Time-Clock Date 1 to 31 Read Only Read Only 
%SR48 RTC_MON Real-Time-Clock Month 1 to 12 Read Only Read Only 

%SR49 RTC_YEAR Real-Time-Clock Year 
1996 to 
2095 

Read Only Read Only 

%SR50 RTC_DAY Real-Time-Clock Day (1=Sunday) 1 to 7 Read Only Read Only 
%SR51  Network Error Count  Read Only Read Only 
%SR52  Watchdog-Tripped Error Count  Read Only Read Only 
%SR53-54 Reserved     
%SR55.13  Self-Test: Battery Low or Missing  Read Only Read Only 

%SR56    LAST_KEY 

Key Currently Pressed  
No key = 0 (No key pressed since 
power-up) 
F1 = 1 
F2= 2 
F3= 3 
F4 = 4 
F5= 5 
F6= 6  
F7=7 
F8= 8 
F9= 9  
F10 = 10 
F11= 11 

0 to 255 
 

Read Only 
 

Read Only 
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Table 14.3 – %SR Registers – Master %SR Table  

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 
F12 = 12 
Enter = 13 
+/ - = 14 
. (dot) = 15 
0 = 16 
1 = 17 
2 = 18  
3 = 19 
4 = 20 
5 = 21 
6 = 22 
7= 23 
8 = 24 
9 = 25 
System = 26 
Escape = 27 
Left = 28 
Right = 29 
Up = 30 
Down = 31 
Shift = 32 
Soft Key 1 = 34 
Soft Key 2 = 35 
Soft Key 3 = 36 
Soft Key 4 = 37 
Soft Key 5 = 38 
Soft Key 6 = 39 
Soft Key 7 = 40 
Soft Key 8 = 41 
Release = 255 (Keys pressed since 
power-up but not currently) 
*Excludes RCC Units  

%SR57  

LCD Backlight Dimmer Register 
0-100 = 0% to 100% On 
100-255 = 100% On 
*Excludes RCC Units  

0 to 255 Read/Write Read/Write 

%57.16  
Temporarily disable Screen Saver  
*Excludes RCC Units  

 Read/Write Read/Write 

%SR58 USER_LEDS User LEDs   Read/Write Read/Write 

%SR59  
Engine Build Number (Only last three 
numbers displayed)  

 
 

Read Only Read Only 

%SR60  

Build Option 
Build Test = 0 
Build Beta = 1 
Build Product = 2 

0 to 2 
 

Read Only 
 

Read Only 

%SR61 NUM_IDS Number of CsCAN Network IDs  Read Only Read Only 

%SR62-100 Reserved 
 
 

   

%SR101.3  
WebMI License Details – WebMI server 
status 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR101.4  
WebMI License Details – WebMI user 
logged in status 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 
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Table 14.3 – %SR Registers – Master %SR Table  

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR101.8-
101.16 

 
WebMI License Details – Number of 
users 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR102-107 Reserved 
 
 

   

%SR108  
WebMI License Details – Number of 
webpages 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR109  
WebMI License Details – Number of 
datapoints 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR110-112  
WebMI License Details – Expiry date of 
WebMI license 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR113-130 Reserved 
 
 
 

   

%SR131-135  OCS Model: ASCII, 10 characters   Read Only Read Only 
%SR136  Communication Download Timeout  Read Only Read Only 
%SR137  Communication Idle Timeout  Read Only Read Only 

%SR138-148 Reserved     

%SR149-150  
Free-running 10kHz count: 1 count = 
0.1ms  (32-Bit DINT) 

 Read Only Read Only 

%SR151 Reserved     

%SR152  RS-485 Termination   Read / Write Read / Write 

%SR152.1  
MJ2 Termination Enable 
*Excludes RCC972 

 Read / Write Read / Write 

%SR152.2  

MJ3 Termination Enable  
*XL+ Only 
 
RS485 Termination Enable  
* X4 & X7 Only 

 Read / Write Read / Write 

%SR152.3*  
MJ1 Termination Enable  
*XL+, XLE, XLT, RCC2414 Only 

 Read / Write Read / Write 

%SR152.4*  

MJ1 Biasing  
*XL+ Only 
 
CAN Termination Enable  
*X4 & X7 Only 

 Read / Write Read / Write 

%SR153-163 Reserved      

%SR164  FailSafe / Clone     

%SR164.1  RS485 Port Biasing #1 (MJ1 or MJ2)  Read / Write Read / Write 
%SR164.2  RS485 Port Biasing #2 (MJ2 or MJ3)  Read / Write Read / Write 

%SR164.3 AUTO_RESTRD 
Indicates Automatic Restore Operation 
has been performed 

 Read Only Read Only 

%SR164.4 BCKUP_TAKN 
Indicates Backup of Registers has been 
taken 

 Read Only Read Only 

%SR164.5 EN_AUTO_RN 
Enable AUTORUN – Sets “Enable 
AutoRun” to “Yes” or “No” 

 Read / Write Read / Write 
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Table 14.3 – %SR Registers – Master %SR Table  

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR164.6 EN_AUTO_LD 
Enable AUTOLOAD – Sets “Enable 
AutoLoad” to “Yes” or “Not”  

 Read / Write Read / Write 

%SR164.7 STRT_BCKUP 
Start Backup trigger bit – Setting TRUE 
starts backup of all register data  

 Read / Write Read / Write 

%SR164.8 CLR_BACKUP 
Clear Backup trigger bit – Setting TRUE 
clears backup of all register data (if a 
backup was done previously)  

 Read / Write Read / Write 

%SR164.9 MAKE_CLONE 
MAKE_CLONE trigger bit = Setting 
TRUE does a Load Clone (if a media 
card is present)  

 Read / Write Read / Write 

%SR164.10 LOAD_CLONE 
LOAD_CLONE trigger bit – Setting TRUE 
does a LOAD CLONE (if a media card is 
present that contains clone files) 

 Read / Write Read / Write 

%SR164.11 MK_CLN_FL 
Make Clone Fail (This bit goes high 
when Make/Create Clone fails)  

 Read / Write Read / Write 

%SR164.12 
 

LD_CLN_FL 
Load Clone Fail (This big goes high 
when Load Clone fails)  

 Read / Write Read / Write 

%SR164.14   

Set to 1 to restore data manually, and 
this in turn sets %SR164.15 to 1.  
Set to 0 to abort restore operation. 
*RCC Units Only 

 Read / Write Read / Write 

%SR164.15  

Set to 1 for manual restore of data.  
Set to 0 to complete the restore 
operation.   
*RCC Units Only 

 Read / Write Read / Write 

%SR165-166 Reserved     

%SR167  
Screen Update Time, Default= 5 
*X4 & X7 Only – Default = 10  

2 to 50 Read/Write Read/Write 

%SR168-170 Reserved     
%SR171  X-Coordinate Touched  Read Only Read Only 
%SR172  Y-Coordinate Touched  Read Only Read Only 
%SR173  System-Function Disable,  0 to 1 Read / Write Read / Write 
  %SR174  Removable Media Protect  Read/Write Read/Write 
%SR174.1  Request Media Card be Removed  Read / Write Read / Write 
%SR174.2  Indicates safe to remove Media  Read / Write Read / Write 
%SR175  Removable Media - Status  Read Only Read Only 

%SR176-177  
Removable Media Free Space (32-Bit 
DINT) 

 Read Only Read Only 

%SR178-179  
Removable Media Total Space (32-Bit 
DINT) 

 Read Only Read Only 

%SR180 Reserved     

%SR181 ALM_UNACK 
Bits 1-16 indicate Unacknowledged 
in Alarm Groups 1-16 

 Read Only Read Only 

%SR182 ALM_ACT 
Bits 1-16 indicate Active 
in Alarm Groups 1-16 

 Read Only Read Only 

%SR183 SYS_BEEP 
Beep on Keypress Enable  
0= Disabled 
1= Enabled 

0 to 1 Read / Write Read / Write 

%SR184 USER_BEEP 
Internal Beeper 
0=OFF 
1=ON 

0 to 1 Read/Write Read/Write 

%SR185  
Screen Saver Enabled  
0= Disabled 
1= Enabled 

0 to 1 Read Only Read Only 



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  113 | 168 
 

Table 14.3 – %SR Registers – Master %SR Table  

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 
NOTE: See %SR57.16  

%SR186  Screen Saver Time in minutes (delay) 5 to 1200 Read Only Read Only 
%SR187 NET_USE Network Usage (Avg) 0 to 1000 Read Only Read Only 
%SR188  Network Usage (Min) 0 to 1000 Read Only Read Only 

%SR189  
Maximum Net Usage of all units on the 
CAN network 

0 to 1000 
 

Read Only 
 

Read Only 

%SR190 NT_TX_AVG Network TX Usage % ( / 10) (Avg) 0 to 1000 Read Only Read Only 
%SR191  Network TX Usage % ( / 10) (Min)  0 to 1000 Read Only Read Only 
%SR192  Network TX Usage % ( / 10) (Max) 0 to 1000 Read Only Read Only 

EXTENDED SYSTEM REGISTERS 
%SR193 ONLINE_CHG Online Change    
%SR193.1  TRUE if 2 programs in target FLASH  Read Only Read Only 

%SR193.2  
TRUE to switch programs, FALSE when 
complete 

 Read Only Read Only 

%SR193.3  
TRUE if executing program is 
temporary test 

 Read Only Read Only 

%SR193.4  
TRUE during last scan of switched-from 
program 

 Read Only Read Only 

%SR193.5  
TRUE during first scan of switched-to 
program 

 Read Only Read Only 

%SR193.6  
TRUE to revert to FLASH and delete all 
RAM; FALSE when complete 

 Read Only Read Only 

%SR193.9 
 
 

TRUE if error in temporary program  Read Only Read Only 

%SR194  
Battery Charge Temp Low 
*XL+ Only – Frequency in MHz 

 Read Only Read Only 

%SR195  
Battery Charge Temp High  
*XL+ Only – in degree centigrade 

 Read Only Read Only 

%SR196  

Charging State  
 
NOTE: Refer to MAN1142 for more 
details on Rechargeable Batteries  
 
0=Waiting 
1=Normal Charging 
2=Hot Charge  
3=Hot Charge  
4= Battery Hot  
5= Cold Charge  
6=Battery Cold  
7=No Battery  
8= Not Charging (after 8 hours of 
charging)  
9= CPU Hot, not charging  
10 Battery voltage <2V, not charging  
11= First 2 minutes Init Wait (Not 
Charging)  

0 to 11 
 

Read Only 
 

Read Only 

%SR197  Charging Current Max mA  Read Only Read Only 
%SR198  Battery Voltage is mV  Read Only Read Only 
%SR199 Reserved     
%SR200  InitRD Version ( /100)  Read Only Read Only 

%SR201-205  
Linux Kernel version:  ASCII, 10 
characters 

 Read Only Read Only 
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Table 14.3 – %SR Registers – Master %SR Table  

Register 
Default I/O 

Name 
Description 

Min-Max 
Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 
%SR206-
208 

Reserved 
 

   

%SR209.3  
WebMI Server Status. Bit 3 is ON if 
server running.  

 Read Only Read Only 

%SR209.4  
WebMI User Logged in Status. Bit 4 is 
ON if 1 or more users logged in.  

 Read Only Read Only 

%SR209.8-
209.16 

 
Number of Users. Shows in upper byte 
in decimal format.  

 Read Only Read Only 

%SR210 
 

Time Zone: set in minutes + / - UTC.  
(Ex: EST is -4 hours = -240 minutes)  

 Read/Write Read/Write 

%SR211 

 

Daylight Saving: YES = 1 
Daylight Saving: NO = 0 
(If daylight saving is enabled, one hour 
will be added to the local time). 

 Read/Write Read/Write 

%SR212  UTC – Seconds  Read Only Read Only 
%SR213  UTC – Minutes  Read Only Read Only 
%SR214  UTC – Hours  Read Only Read Only 
%SR215  UTC – Date  Read Only Read Only 
%SR216  UTC – Month  Read Only Read Only 
%SR217  UTC – Year  Read Only Read Only 

%SR218 

 
 
 
 
 

Number of Webpages, license detail 
(XLE/XLT, X2, X4, & X7 use %SR101 & 
%SR108-112 for WebMI License Details.) 

 Read Only Read Only 

%SR219  
Number of Data Points, license detail. 
(XLE/XLT, X2, X4, & X7 use %SR101 & 
%SR108-112 for WebMI License Details) 

 Read Only Read Only 

%SR220-222  

Expiration Date of WebMI License, 
license detail.  
(XLE/XLT, X2, X4, & X7 use %SR101 & 
%SR108-112 for WebMI License Details) 

 Read Only Read Only 

 
For additional information on system bits and registers, refer to the Help file in Cscape. 
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14.3 Register Map for XLE/XLT I/O 
 

Table 14.3 – I/O Register Map 

Registers 
Description 

XLE/XLT with  
no I/O 

XLE/XLT with  
102 I/O 

XLE/XLT with  
103 I/O 

XLE/XLT with  
104 I/O 

XLE/XLT with  
105 I/O 

XLE/XLT with  
106 I/O 

%I1-%I12 Unused Digital Inputs 
%I13-%I16 Unused Reserved Digital Inputs Reserved 
%I17-%I24 Unused Reserved Digital Inputs Reserved 
%I25-%I31 Unused Reserved 

%I32 Unused Output Fault Output Fault Output Fault Unused 
%Q1-%Q6 Unused Digital Outputs 
%Q7-%Q12 Unused Reserved Digital Outputs 

%Q13-%Q16 Unused Reserved 
Digital 

Outputs Reserved 
%Q17 Unused Totalizer: Clear HSC1, Quadrature: Clear Quad1 
%Q18 Unused Totalizer: Clear HSC2, Quadrature: Set Quad1 
%Q19 Unused Totalizer: Clear HSC3, Quadrature: Clear Quad2 
%Q20 Unused Totalizer: Clear HSC4, Quadrature: Set Quad2 
%Q21-
%Q24 Unused Reserved 

%AI1-%AI2 Unused Analog Inputs Reserved 

%AI3-%AI4 Unused 
Analog 
Inputs Reserved 

%AI5-%AI6 Unused HSC1 Accumulator 
%AI7-%AI8 Unused HSC2 Accumulator 

%AI9-
%AI10 Unused HSC3 Accumulator 
%AI11-
%AI12 Unused HSC4 Accumulator 

%AI33 - 
%AI38 Unused 

Analog 
Inputs 

%AQ1-
%AQ2 Unused PWM1 Duty Cycle 
%AQ3-
%AQ4 Unused PWM2 Duty Cycle 
%AQ5-
%AQ6 Unused PWM Prescale 
%AQ7-
%AQ8 Unused PWM Period 
%AQ9-
%AQ10 Unused Analog Outputs 

Unused = These registers can be used as general purpose registers 
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14.4 Resource Limits  
 

Table 0.4 - Resource Limits 
Resource Value 

%S 13 
%SR 192 
%T 2048 
%M 2048 
%R 9999 
%K 10 
%D 1023 
%I 2048 
%Q 2048 
%AI 512 
%AQ 512 
%IG 64 
%QG 64 
%AIG 32 
%AQG 32 

Network Ports 
CsCAN 

(Optional depending on model.) 
Controllers Per Network 253 

Keypad 20 keys (10 fn keys and 4 soft keys) 

Display 
128x64 LCD Backlit, monochrome for XLE 
160x128 LCD Backlit, monochrome for XLT 

Screen Memory 1M 
User Screens 1023 

Data Fields Per User Screen 50 
Ladder Code 256k 
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CHAPTER 15: CSCAPE CONFIGURATION 
 
 
15.1 Overview 
 
XLE/XLT hardware is programmed with a Windows based PC application called Cscape. This 
application can be used to program, configure, monitor and debug all aspects of the XLE/XLT 
unit. Please see the on-line help provided with Cscape for additional details. 
 
15.2 Updating Programs from First Generation to Second Generation XLE/XLT   
 
After 11 years on the market, the XLE and XLT hardware was updated to provide better 
performance and additional features. Generation 1 products did not feature integrated 
Ethernet, so if the part number contains an E like HE-XT1E0 or HE-XE1E6 it is a second 
generation unit. Devices without integrated Ethernet can be checked using the hardware 
revision after the part number. Hardware revision “T” and later are Generation 2 products. 
For example, XE-XE103TB is hardware revision “T.” 
 
Cscape programs created for the first generation XLE and XLT can be loaded into Generation 2 
products without any changes.  
 
If you created PGM files to be loaded into XLE or XLT devices via the microSD card, then these 
can be used.  
 
If your configuration contains no downloadable protocols, then you can use the PGM without 
any changes.  
 
If your PGM contains downloadable protocols, then you can either recreate the PGM with 
Cscape 9.8 or later, or you can use the PGM Update utility that distributes with Cscape 9.8 or 
later. The utility is located in the main Cscape folder and is called PGMUpdateUtility.exe. 
Running this allows inputting the old PGM filename and it will update it to a new file for download 
into Generation 2 (Rev T or later) products. 
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15.3 Cscape Status Bar   
 
When the XLE/XLT is connected to a PC using Cscape software a Status Bar appears at the 
bottom of the screen. The Cscape Status Bar can be used to determine if communications have 
been established between the XLE/XLT and the Cscape program. Components of the Cscape 
Status Bar are explained below.  
 
 
 
 
 
 
 
 
 
  

Ready User: 
NONE 

HE-XExx1-CsCAN 
(Model=) 

Equal  Local :1   Target :2(R) [no 
forces] 

MOD 

Equal Indicator – indicates whether the current program in Cscape is equal to the program 
stored in the Target Controller. 
• If Equal, the program in Cscape is the same as the program stored in the Target Controller. 
• If Not Equal, the program in Cscape is not the same as the program stored in the Target 

Controller. 
• If Unknown, there may have been a change since the last time the program in Cscape was 

compared to the Target Controller.  

Communications Status - indicates the current status of the 
“pass through” Connector.    

 
• Local: xx – indicates the Network ID of the XLE/XLT to 

which the Cscape program is physically connected through 
its serial port. It can serve as a pass-through device to 
other nodes on the network.   

 
• Target: yy(R) – indicates the Network ID of the device with 

which the Cscape program is exchanging data.  
NOTE: The Local unit and Target unit can be the 
same unit or they can be separate units. 

 
The following are status indicators: 
 
(R) – Running 
(D) - Do I/O 
(I) – Idle 
(?) – Cscape is not communicating with the remote unit.  
[no forces] – indicates no I/O has been forced. 

Message Line - 
The contents of 
these messages 
are context 
sensitive. The 
Message line can 
be empty.   

Current User - 
indicates who is logged 
(for security purposes). 

Controller Model – Network (Model Confirmation) 
 
• Controller Model indicates the controller model for 

which the program in Cscape is configured.     
 
• Network indicates the type of network that the 

program in Cscape expects to use (e.g., CsCAN). 
 
• (Model Confirmation) provides the following 

indications: 
 
• (Model=) - The actual Target Controller matches the 

configured Controller Model and Network. 
 
• (Model Not=) – The actual Target Controller does not 

match the configured Controller Model and Network. 
 
• (Model ?) – There may have been a change since the 

last time the Target Controller was compared to the 
configured Controller Model and Network. 

File Modified Indicator - indicates that the file in 
the selected window has been modified but has 
not been saved.  
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15.4 Establishing Communications Overview 
 
The XLE/XLT can communicate with Cscape using USB to serial adapters, Ethernet, USB, CAN 
(CsCAN) or modems. For communications other than RS-232 serial please refer to the manual 
that ships with the adapter hardware being used for programming. 
 
To communicate with the XLE or XLT via USB you will need the Automated Driver Installer 
located on the Horner Automation web site.  The drivers may be loaded from the HE-XEC 
Ethernet Utility / HTTP Web Server Demo / Communications Drivers  section of 
the support files page on our website, found 
here:  https://hornerautomation.com/support-files . 
 
Next, connect a PC’s (Personal Computer running a Windows Microsoft operating system) USB 
port via USB cable to the USB mini B port on the XLE/XLT OCS. 
 
 

 
 

 
 
 
 
 
  

https://hornerautomation.com/support-files/#collapse_2
https://hornerautomation.com/support-files/#collapse_2
https://hornerautomation.com/support-files
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The PC will detect a new device has been plugged into the USB port. 
Open Cscape and the first screen to open will be the Connection Wizard. Select USB and 
Next>> then Finish.  
 
 

 
 

 
Figure 15.1 – Cscape Connection Wizard Screenshots 
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If the Connection Wizard does not pop up upon opening Cscape, then select Controller (in the 
Cscape tool bar) → Connection Wizard, choose your connection method. If you are connecting 
for the first time, we suggest connecting via USB.  
 

 
 
 

 
Figure 15.2 – Cscape Connection Wizard Screenshots 

 
If Controller USB COM Port is not present in the dropdown list, the Windows operating system 
has not yet recognized the OCS as an installed device. Be sure the installation process is 
complete and that the correct drivers are installed. The Connection Wizard must be 
completely closed and reopened to refresh the USB dropdown list.  
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An alternate way to select the COM setting is to go to Cscape → Tools → Application Settings 
→ Communication → Configure and choose connection method in Add Target.  
 

 
 

Figure 15.3 – Cscape: Alternative Connection Method Screenshot 
 

 
Figure 15.4 – Add Target Screenshot in Cscape 
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Figure 15.5 – Cscape: Add Target  

 
 
NOTE: The following fields need to be filled for communication configuration if Cscape 
Connection Wizard was not used. Refer to Table 15.1.  
 

1. Target Name 
2. Connection Medium 
3. Connected Device 
4. Connection Settings  
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Table 15.1 – Communication Configuration Dialog  
Target Name Name for connection. This is not a mandatory column to be filled, by 

default Cscape will populate ‘Default1’ in edit box. 

Connection Medium 
Com Port Select this option to communicate over serial communication with the 

device. The port number can be configured here. 
Ethernet Select this option to communicate over Ethernet. Provide the IP address 

of the device and select the mode: HE GSM GPRS mode, Built in/ ETN 
Ethernet mode, or HE XEC Ethernet mode. 
 
Select HE GSM GPRS mode if communication with XL series controller on 
GPRS is required and the device has GSM modem installed in XL series 
controller. 

  
Select Built in/ ETN Ethernet mode if the device has on-board Ethernet 
port. 
  
Select HE XEC Ethernet mode if the device has Ethernet comm. option 
board installed in XL series controller.  

  
NOTE: For GPRS connectivity, GPRS configuration from Programs → 
Messaging → GPRS needs to be done. 
 
NOTE: The controller should support the type of connectivity selected 
and configured for Ethernet communication. 

CAN Interface Select this option to communicate over CAN. This option requires 
additional hardware to be installed with the PC to be able to do so. Select 
the type of hardware installed from the dropdown. 

Installed Modem Select this option to communicate to the device through the internal 
modem of the computer. Cscape will automatically detect the internal 
modem attached with PC and list in the attached drop down. User can 
select modem and telephone number for target controller. 

NOTE: Cscape will do necessary initialization for the selected internal 
modem. 

USB Select this option to communicate over USB. Now Horner devices and 
Horner USB to serial converters are recognized and can be specifically 
selected. 

Connected Device 
NOTE: This configuration is required if the controller to which Cscape is communicating is connected 
to a CsCAN network. 
Connected Device By default, this option is selected and networking feature of Cscape is 

disabled. 
Target Node ID On selecting this option, Networking feature of Cscape is enabled. CsCAN 

ID for the target controller to be provide here. 

Connection Settings (General Communication Settings) 
Maximum Baud Rate Select the baud rate for serial communication. 
Timeout Select the communication timeout. 

 
NOTE: Select a larger timeout for GPRS and installed modem 
communication configuration 

  



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  125 | 168 
 

If communications are successful, the message line should show “USB (COM8)” for this 
example, and an (R) should follow the Target number. For more information on the status bar, 
see the status section above in this chapter, section Cscape Status Bar. 
 

 
 

 
 
      Local ID and Target ID Match 
 

 
 
If the controller is not communicating, you may need to set the target ID of the controller in 
Cscape or on the unit. The Target ID allows directing communications to a particular unit 
when multiple units are connected via a CsCAN network. Units without CsCAN network ports 
respond to any network ID and do not require the ID to be configured. 
 
15.4.1 Communicating via MJ1 Serial Port 
 
If a serial programming connection is to be used and the PC has a 9-pin serial COM port, 
which is increasingly rare, there is nothing to install assuming the port already works. All that 
is needed is a programming cable to go from the COM port to the OCS programming port. 

 
If a serial programming connection is to be used and the PC does not have a COM port, a USB-
to-Serial adapter may be used. Horner offers the HE500USB600 USB-to-RS232 Serial 
Adapter, which comes as part of the HE-XCK and HE-CPK programming kits. Drivers for it are 
normally found automatically by the Windows operating system as long as an internet 
connection is established. Otherwise, the drivers may be loaded from the Horner FTP site at 
https://hornerautomation.com/support-files/ . 

 
Connect the PC’s serial port or the USB-to-Serial adaptor to the port labeled MJ1 on the 
XLE/XLT. 

 
The instructions are similar to using a USB port, as shown above. In the Connection Wizard, 
select the “Serial” option. 

 
If communications are successful, the target indicator should show the mode of the controller 
Target: yy(R) as shown above in this chapter, section Cscape Status Bar. 

 
If the controller is not communicating, you may need to set the target ID of the controller in 
Cscape or on the unit. The Target ID allows directing communications to a particular unit 
when multiple units are connected via a CsCAN network. Units without CsCAN network ports 
respond to any network ID and do not require the ID to be configured. 
 

To check or change the ID on the XLE/XLT OCS, press the UP and DOWN keys on the XLE/XLT 
simultaneously to enter the System Menu. The first item in the menu is Set Network ID. Pressing 
Enter allows you to vie or modify the ID of the unit.  
 
To change the Target ID of Cscape use the Controller → Set Target Network ID dialog.   

When connected directly to the controller to which 
Cscape communications are required, the Local ID 
and the Target ID should match. 
 

https://hornerautomation.com/support-files/
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15.4.2 Communicating via On Board Ethernet Port 
 
From Cscape go to Controller → Hardware Configuration and do auto configuration for the 
connected controller, Click on Config of Ethernet & go to Module Setup. 
 
The IP address, Net Mask, and Gateway of the controller may be temporarily set from the 
system menu under the Set Networks menu item. Once running or power cycled the 
configuration will come from the Cscape configuration stored in the unit. 
 
In Module configuration dialog, go to IP Address field enter unused IP Address and configure 
unused registers in Register field & then click OK. Screen shot for the same as follows: 
 

 
Figure 15.6 – LAN1 Configuration Screen 

 
 
Download the configuration in to Controller. Connect LAN cable to the Controller in default 
LAN Port.  
 
From Cscape go to Tools → Editor Options → Communication Port → Configure. Select 
Ethernet and enter IP address which is configured in the file. Select mode as XL Series mode 
from drop down list. 
 
The controller should get connected to Cscape. If communications are successful, the target 
indicator should show the mode of the controller Target: yy(R) as shown in the as shown 
above in this chapter, section Cscape Status Bar.  
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15.5 Models supported  
 
Cscape 9.80 and newer supports all models and options offered in the XLE/XLT line. For the 
latest version of Cscape or compatibility information, please refer to our websites.  
 
15.6 Configuration  
 
An overview of configuration: 
 
An overview of configuration: 

(1) Start the configuration by selecting the Controller → Hardware Configure menu item. 
(2) If the controller is connected to the PC press the Auto Config System button to 

automatically detect the Base model, I/O and any communication options. 
(3) If the controller is NOT connected: 

a. Select Series → XL Series  
b. Select Device Type → XLE/XLEe or XLT/XLTe 
c. Select Model # → (See part number building below) 

 

 
 

(4) Select Local I/O → Config → Module Setup.   
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(5) The I/O Module Configuration dialog (Specifically the Module Setup tab) provides four 

buttons to configure all the I/O: Digital In/HSC, Digital Out/PWM, Analog In, Analog Out.  
Configure each I/O feature as needed. For additional information on I/O, refer to the 
chapters covering General I/O or High Speed I/O in this manual. 
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15.7 Digital / HSC Input Configuration  
 
The following figure illustrates the Digital / HSC Input Configuration dialog.  To open the I/O 
configuration dialogs, select Controller → Hardware Configuration → Local I/O → Config (top 
button) → Module Setup.   
 

 
Figure 15.7 – Digital / HSC Input Configuration Dialog 

 
 
The Active mode group box allows the user to select if inputs are active high (Positive logic) or 
active low (Negative logic). It is important that this setting matches the jumper settings on the 
hardware. 
 
The High-Speed Counters group box contains all the windows that are used to configure the 
four available high-speed counters on the XLE/XLT. To configure a counter, the user needs to 
set the type, mode, and counts per rev. 
 
The type drop down includes the following options: 
 

- Disabled 
- Frequency 
- Totalize 
- Pulse 
- Quadrature 
- Marker (Only available in counter #3 if counter #1 is set to quadrature.) 

 
The mode drop-down items are set according to the type selection. The Counts Per Rev. window 
is enabled/disabled according to the type selection as well.  
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15.8 Digital / PWM Output Configuration  
 
The following figure illustrates the Digital / PWM Output Configuration dialog. To open the I/O 
configuration dialogs, select Controller → Hardware Configuration → Local I/O → Config (top 
button) → Module Setup.   
 

 
Figure 15.8 – Digital / PWM Output Configuration Dialog 

 
 
The Q1 and Q2 group boxes allow the user to specify the operation of the multi-function outputs.  
 
The PWM State On Controller Stop group box contains items that allow the user to specify how 
the PWM outputs behave when the controller is stopped. These items can either hold their value 
or default to some value when the controller is stopped. 
 
NOTE: The PWM outputs are set to the OFF state at power-up and during program download 
and remain in that state until the unit is placed in RUN. 
 
The Output State On Controller Stop group box contains items to allow the user to specify how 
the remaining digital outputs behave when the controller is stopped. These items can either 
hold their value or default to some value when the controller is stopped. 
  



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  131 | 168 
 

15.9 Analog Input Configuration 
 
The following figure illustrates the Analog Input Configuration dialog.  To open the I/O 
configuration dialogs, select Controller → Hardware Configuration → Local I/O → Config (top 
button) → Module Setup.   
 

 
Figure 15.9 – Analog Input Configuration Dialog 

 
The Channel x drop down windows allows the user to specify the mode for each analog input to 
operate. The Channel x drop down windows are enabled/disabled according to which model is 
being configured. All the models have the following modes available: 
 

- 0..10V 
- 0..20mA 
- 4..20mA 

 
On Model 105, channels 3 and 4 also have the following modes available: 

- 100mV 
- PT100 DIN RTD, 1/20°C 
- Type J Thermocouple, 1/20°C 
- Type K Thermocouple, 1/20°C 
- Type N Thermocouple, 1/20°C 
- Type T Thermocouple, 1/20°C 
- Type E Thermocouple, 1/20°C 
- Type R Thermocouple, 1/20°C 
- Type S Thermocouple, 1/20°C 
- Type B Thermocouple, 1/20°C 

 
The Filter Constant provides filtering to all channels. 

 
On Model 106, the value given for RTD and T/C is an integer, so the user should divide by 10.  
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15.10 Analog Output Configuration  
 
The following figure illustrates the Analog Output Configuration dialog. To open the I/O 
configuration dialogs, select Controller → Hardware Configuration → Local I/O → Config (top 
button) → Module Setup.   
 

 
 

Figure 15.10– Analog Output Configuration Dialog 
 
 
The Output value on Stop group box contains items that allow the user to specify how the 
analog output channels behave when the controller is stopped. The outputs can either hold their 
value or default to a value when the controller is stopped. 
 
The Output Mode group box allows the user to select the operating modes for each of the analog 
outputs. The modes include the following: 
 

- 0..10V 
- 0..20mA 
- 4..20mA 
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15.11 Scaling Analog Inputs 
 
To access the Advanced Math Scaling function, select Tools → Project Toolbox. This will open 
a side bar, and then select Advanced Math → Scale. 
 

 
Figure 15.11 –Scaling Analog Inputs 
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Example 1 
 The Cscape Scale function, found in the Advanced Math functions, allows for very easy 
conversion of the raw input value into a meaningful reading. For example, a pressure 
transducer may be specified as a 4-20mA signal to signify a 0-2000 psi pressure reading.  
With the analog channel set to the 4..20mA range, the raw analog input value, which is in INT 
format ranges from 0 to 4mA to 32000 for 20mA. Use the Scale function to obtain an Integer 
pressure reading using the 0-32000 raw input range and the sensor’s 0-2000psi output 
range. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Example 2: 
If readings with fractions are required, the raw Integer input value must first be translated in 
REAL, or Floating Point format. The Cscape INT-to-REAL Conversion function may be used to 
convert the raw input value from INT to REAL format in an intermediate memory location. The 
SCALE function, specified as REAL type, may be used to scale the converted raw value into a 
reading that supports digits beyond the decimal place, i.e. 475.25psi.  
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CHAPTER 16:  FAIL – SAFE SYSTEM 
 
16.1 Overview 
 
The Fail-Safe System is a set of features that allows an application to continue running 
in the event of certain types of "soft" failures. These "soft" failures include: 
 

• Battery power loss 
• Battery-Backed Register RAM or Application Flash corruption due to, for 

example, an excessive EMI event. 
 
The Fail-Safe System has the following capabilities: 
 

• Manually backup the current Battery-Backed RAM Register Settings into Flash 
memory. 

• Manually restore Register Settings from the values previously backed up in 
Flash to Battery-Backed RAM. 

• Detect corrupted Register Settings at power-up and then automatically restore 
them from Flash. 

• Detect corrupted or empty application in Flash memory at power-up and then 
automatically load the AUTOLOAD.PGM application file from Removable Media 
(Compact Flash or microSD). 

• If an automatic Register Restore or Application Load occurs, the OCS can 
automatically be placed in RUN mode 

 
The fail-safe system can be accessed through the system menu of the controller. A new 
menu “Fail-Safe System” has been added at the end of the main system menu for this. 
Selecting “Fail-Safe System” menu will open the following menu screen: 
 

XLT: 
 

 
 

XLE: 
 

 
Figure 16.1– Fail Safe System Menu  
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16.2 Settings 
 
To use the Fail – Safe feature, the user must do the following: 
 

1. From Cscape, create AUTOLOAD.PGM for the application program using ‘Export to 
Removable Media’. 

2. Place the Removable Media with AUTOLOAD.PGM in the device. 
3. Set the ‘Enable AutoLoad’ option in the device to YES. 
4. Set the ‘Enable AutoRun’ option to YES if the controller needs to be placed in RUN 

mode automatically after automatic restore of data or AutoLoad operation. 
5. Backup the current Battery-Backed RAM Register contents in On-Board Flash memory 

using System Menu options. 
 

 
16.3 Backup / Restore Data 
 
Selecting this option brings up a screen having four operations: 

• Backup OCS Data. 
• Restore OCS Data. 
• Clear Backup Data. 
• Exit 

 
XLE: 

            

 
 

XLT: 
 

 
 

Figure 16.2 – Backup / Restore Data 
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Backup OCS Data:  
 
When initiated, this will allow the user to manually copy Battery-Backed RAM contents on to 
the onboard FLASH memory of the OCS. This will have the effect of backing up all the 
registers and controller settings (Network ID, etc.) that would otherwise be lost due to a 
battery failure. %SR164.4 is set to 1 when backup operation is performed. 

 
XLE: 

 

 
 

XLT: 
 

 
 

Figure 16.3– Backup Registers 
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Restore OCS Data:  
 
When initiated, this will allow the user to manually copy the backed-up data from the onboard 
FLASH to the Battery-Backed RAM. 
A restore operation will be automatically initiated if a backup has been previously created and 
on power-up the Battery-Backed RAM registers fail their check.   
 
The following process is implemented to restore data: 

• The controller will be placed in IDLE mode. 
• Data will be copied from onboard FLASH to OCS Battery-Backed RAM 
• The controller will reset.  
• The controller will be put in RUN mode if the AutoRun setting is ‘Yes’ else it will remain 

in IDLE mode. 
 

XLE: 
 

 
 

XLT: 
 

 
 

Figure 16.4 – Restore OCS Data 
 
%SR164.3 is set to 1 only when an automatic restore operation is performed - not on a manual 
one. This bit is reset to the value of 0 when a new backup is created. 
 
Restoring of data can be manually performed by selecting RESTORE option from the Backup / 
Restore Data menu. This will cause the controller to reset.  
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Clear Backup Data:  
 
When initiated, the backup data will be erased from the onboard Flash and no backup will exist. 
%SR164.4 and %SR164.3 is reset to the value of 0 when backed up data is erased. 
 

XLE: 
 

 
 

XLT: 
 

 
 

Figure 16.5– Clear Backup Data 
 
 
Exit: Goes back to the previous screen. 
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The OCS follows the following sequence in execution of Automatic Restore: 
 

OCS Power Cycle 

Battery Backed RAM 

Registers check failed

Backup  

exists?

Controller placed in 

IDLE mode

Data copied from Onboard FLASH to OCS Battery backed 

RAM

Controller Resets

AutoRun 

Enabled?

OCS put in RUN Mode

OCS put in IDLE 

Mode

NO

YES

YES

NO

Application 

Program erased

 
 

Figure 16.6 – Flow Chart for Automatic Restore  
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AutoLoad 
 
This system menu option allows the user to specify whether the OCS automatically loads the 
application AUTOLOAD.PGM located in Removable Media. 
 
When the AutoLoad setting is enabled (set to YES), it can be manually or automatically initiated 
at power-up. 
  
The automatic initiation will happen only in the following two cases: 

• When there is no application program in the OCS and a valid AUTOLOAD.PGM is available 
in the removable media of the device. 

• When the program residing in onboard memory is corrupted and a valid AUTOLOAD.PGM 
is available in the removable media of the device. 

 
AutoLoad can be manually initiated when the SYS-F3 key is pressed (OCS can be in any of the 
following mode – Idle / Run / DOIO). This also requires a valid AUTOLOAD.PGM to be present in 
the removable media of the device. 
 
When the AutoLoad setting is not enabled (set to NO), OCS will be in IDLE mode and the 
application is not loaded. 
 
If the AUTOLOAD.PGM is security enabled, the user will be prompted to enter the password 
before loading the application. The application will be loaded from the Removable media only 
after getting the correct password. 
 
%SR164.6 can be set to enable AutoLoad feature. 
 

XLE: 
 

 
 

XLT: 
 

 
 

 
Figure 16.7 – AutoLoad Menu 
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The OCS implements the following sequence to execute the AutoLoad function: 
 

Power up OCS 

Application Program absent                

or 

Application Program corrupted

AutoLoad 

Enabled?

AUTOLOAD.PGM present in 

the RM of the device ?

AutoLoad initiated. 

OCS put in IDLE mode

AutoLoad run sequence 

failed (with reasons for 

failure)

NO

NO

YES

YES

AutoRun 

Enabled?

OCS put in RUN Mode

 OCS put in IDLE Mode

NO

YES

 
 
 

Figure 16.8 – Flow Chart for AutoLoad 
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AutoRun 
 
This system menu option, when enabled (YES), allows the user to automatically place the OCS 
into RUN mode after the AutoLoad operation or automatic Restore Data operation.  
 
When the AutoRun setting is disabled (NO), the OCS remains in the IDLE mode after a Restore 
Data or AutoLoad operation. 
 
%SR164.5 can be set by putting the system into RUN mode automatically, once an AutoLoad 
has been performed or an Automatic Restore has occurred. 
 
If for any reason the AutoLoad-Run (Loading the AUTOLOAD.PGM automatically and OCS put 
in RUN mode) sequence does not succeed, a pop-up message box saying "AUTO-LOAD-RUN 
SEQUENCE FAILED" will be displayed. It will also show the reason for its failure. On 
acknowledging this message box the AutoLoad-Run sequence will be terminated, controller 
will return to the first user-screen and will be placed in IDLE mode. 
 

XLE: 
 

 
 

XLT: 
 

 
 

Figure 16.9 – AutoRun Menu 
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CHAPTER 17: CLONE UNIT 
 
 
17.1 Overview 
 
The ‘Clone Unit’ feature allows the user to “clone” the OCS of the exact same model. This 
feature “clones” application program and unit settings stored in Battery backed RAM of an OCS 
into the RM. Refer to the Removable Media chapter for more details on using RM. It can then be 
used to clone a different OCS (same model).  
 
This feature can be used for: 
 

• Replacing an OCS by another unit of the same model. 
• Duplicating or “clone” units without a PC. 

 
 
17.2 Clone 
 
User must perform the following sequence of action to Clone a unit: 
 
1. The ‘Clone Unit’ can be accessed by going to the ‘System Menu’ of the OCS. A new menu 

“Clone Unit” has been added at the end of the main system menu as shown below: 
 

XLT: 
 

 

XLE: 
 

 

 

Figure 17.1– System Menu 
 
2. Selecting “Clone Unit” menu will open the following menu screen: 

 

XLT: 

 

XLE: 

 

 

Figure 17.2 – Clone Unit Menu before Cloning 
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NOTE: 
 

a. In the above Figure 17.2, F3 and F4 are inactive in the Clone Unit. 
b. DSK – when selected shows the number of total and free bytes in Removable Media. 

 
3. Make/Create Clone option enables the user to duplicate / Clone an application file, all unit 

settings and all register values from Battery Backed RAM. 
 

Selecting Make Clone brings up the screen below: 
 

XLT: 

 

XLE: 

 

 

Figure 17.3 – Clone Unit Confirm Screen 
 

 

After confirmation, the OCS will create two new files in the root directory of the Removable 
Media Drive as shown below: 
 
AUTOLOAD.PGM Application file 
CLONE.DAT  File having all unit settings and register values from Battery Backed RAM 
 

XLT: 

 

XLE: 

 

 

 

Figure 17.4 – Clone Unit Files 
 
 

NOTE: Make/Create clone operation automatically includes the security in AUTOLOAD.PGM file 
for security enabled files. 
  



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  146 | 168 
 

4. Once the cloning is successful, the OCS gives a message as below: 
 

XLT: 

 

XLE: 

 

 

 

Figure 17.5 – Cloning Status 
 
Make/Create clone can also be triggered by setting %SR164.9 bit to “1” from Ladder program 
or graphics. Once the operation is completed, this bit is made zero by the firmware. When Make 
clone operation is triggered by this SR bit, it does not ask the user for confirmation to make the 
clone. The success / failure of the operation is also not notified on screen to the user.  
 
In case of failure of “Make Clone” operation, %SR164.11 bit is set to “1” by the firmware and 
never reset.  
 
NOTE: Backup of registers in flash memory is not performed by the Clone Feature. If user 
desires, Backup should be done as explained in the Fail-Safe System chapter. 
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17.3 Load Clone 
 
This option loads the application, all unit settings and register values from Removable media to 
the Battery backed RAM (Regardless of AutoLoad settings) and then resets the OCS for the 
settings to take effect. 
 
User must perform the following to Load the Clone: 
 
1. Select “Clone Unit” from main system menu of OCS as shown below: 
 

XLT: 

 

XLE: 

 

Figure 17.6 – System Menu 
 
Selecting “Clone Unit” menu will open the following menu screen. Select “Load Clone”. 
  

XLT: 

 

XLE: 

 

Figure 17.7– Clone Unit Menu after Cloning 
 
2. User must confirm Load Clone as shown below: 
 

XLT: 

 

XLE: 

 

Figure 17.8 – Load Clone Confirm Screen 
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3. After confirmation, all unit settings and register values will be loaded from the Removable 

media to the Battery backed RAM (Regardless of AutoLoad settings) and then the OCS resets 
at which stage the settings take effect. 

 
NOTE: For security enabled files, Load clone asks for password validation before loading the 
application. 
 
Load clone can also be triggered by setting %SR164.10 bit to “1” from Ladder program or 
graphics. Once the operation is completed, this bit is made zero by the firmware. When the Load 
clone operation is triggered by this SR bit, it does not ask the user for confirmation to load the 
clone. The success / failure of the operation is not notified on the screen to the user.  
 
In case of failure of the “Load Clone” operation, %SR164.12 bit is set to “1” by the firmware 
and never reset. 
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CHAPTER 18: MAINTENANCE 
 
 

18.1 Firmware Updates  
 
The XLE/XLT products contain field updatable firmware to allow new features to be added to 
the product at a later time. Firmware updates should only be performed when a new feature 
or correction is required. 
 
 
 
 
 
 
 
 
Steps for updating the firmware: 
 

1. Establish communication between Cscape and the controller using a direct serial 
connection to MJ1. 

2. Make sure your application is available on your PC or upload the application. 
3. Make sure the machinery connected to the XLE/XLT is in a safe state for firmware 

update (see warning above). 
4. Start the firmware update by selecting File → Firmware Update Wizard. 
5. The correct product type should be selected, if it is not select the type of controller from 

the drop-down list. 
6. Press the start button. 
7. Wait for the firmware update to complete. 
8. If there is a communication failure check the cable, connections and comm. port setting 

and try again. 
9. Firmware updates typically delete the user applications to ensure compatibility. You will 

need to reload your application. 
10. Test the operation of the equipment with the new firmware before returning the 

XLE/XLT system to an operation mode. 
  

WARNING: Firmware updates are only performed when the equipment being controlled by 
the XLE/XLT is in a safe, non-operation state. Communication or hardware failures during 
the firmware update process can cause the controller to behave erratically resulting in 
injury or equipment damage.  Ensure the functions of the equipment work properly after 
a firmware update before returning the device to an operational mode.  
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18.2 Backup Battery 
 
The XLE/XLT contains an internal lithium battery that is used while power is disconnected for 
the following functions:  

• Run the real-time clock 
• Maintain retentive registers 
• Maintain the application program  

 
Under normal conditions the battery in the XLE/XLT should last seven (7) to ten (10) years. 
Higher operating temperatures or variations in batteries may reduce this time. 
 
Preventing Program Loss:  An available option to prevent the loss of program should the 
battery be drained is to use the Backup/Restore function which is part of the Fail-Safe 
System. This feature is highly recommended and is accessible from the System Menu and 
from program logic. Backup/Restore DOES NOT require the installation of a microSD card in 
order to prevent program loss. Refer to the Fail-Safe System chapter for complete details.   
 
The battery will generally last seven (7) to ten (10) years. Environmental conditions, including 
extreme temperatures and humidity, can affect battery life. If the battery is older than seven 
(7) to ten (10) years old, it is recommended that it be replaced as preventative maintenance. 
 
 
 
 
WARNING: DO NOT USE IF BATTERY IS LEAKING OR HAS BEEN DAMAGED.  
 
WARNING: LITHIUM BATTERIES MAY EXPLODE OR CATCH FIRE IF MISTREATED.  
DO NOT RECHARGE, DISASSEMBLE, HEAT ABOVE 100° C (212° F) INCINERATE, OR 
PUNCTURE. 
 
WARNING: EXPLOSION HAZARD – BATTERIES MUST BE ONLY BE CHANGED IN A AREA 
KNOWN TO BE NON-HAZARDOUS.  
 
WARNING: Disposal of lithium batteries must be done in accordance with federal, state, and 
local regulations. Be sure to consult with the appropriate regulatory agencies before 
disposing batteries. In addition, do not recharge, disassemble, heat or incinerate lithium 
batteries. 
 
WARNING:  Do not make substitutions for the battery. Be sure to only use the authorized part 
number to replace the battery. 
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NOTE: The XLE/XLT uses a 3V coin lithium battery, part no. HEBAT00009 available from 
Horner Automation. 
 
Below are the steps to replace the battery. 

1. Make sure the user program and any data stored in retentive memory is backed up. 
2. Disconnect all power from the XLE/XLT unit including I/O power. 
3. Using a Phillips screwdriver, remove the four (4) screws on the back of the XLE/XLT unit 

by turning the four (4) corner screws counterclockwise. Remove the back cover. 
4. Carefully remove the I/O board (if present) by lifting it straight up. 
5. Remove the old battery. It may require a small flat blade screwdriver to lift it from the 

holder. 
6. Dispose of the battery properly; see the above warning on disposal regulations. 
7. Slide the new battery into the holder. Make sure the battery is inserted with the proper 

polarity. The top tab of the battery holder should contact the positive (+) terminal of the 
battery. 

8. Replace the I/O circuit board by aligning the edges with the guideposts. Align the I/O 
board bus connector to bus pins, and then gently press on the I/O circuit board until it 
is seated.  

9. Place the back cover back on the unit. 
10. Place the screw back into the hole and turn the screw slowly counterclockwise until 

“clicks” into the threads. This will prevent the screw from being cross threaded. Now 
turn the screw clockwise until the cover is firmly secured. Repeat this process for all 
four (4) screws. Recommended torque is 3 - 4 in-lbs (0.34 – 0.45 Nm).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

001XLE054
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CHAPTER 19: MODBUS COMMUNICATIONS 
 
19.1 Modbus Overview 
 
For complete Modbus instructions, please refer to the Help file in Cscape.  
 
Modbus (serial) is a popular, de-facto standard protocol that allows industrial devices from 
multiple manufacturers to easily share data in real-time. For Modbus serial communications, 
the XLE/XLT can act as either a Master or a Slave.  
 
Modbus protocol (serial) allows for one master and multiple slaves. The master always 
initiates the conversation by sending a request to a particular slave. Only the addressed slave 
will send a response when the request is completed. Should the slave be unable to complete 
the request, it returns the appropriate error response. Should the slave be unable to respond, 
the master’s timeout timer expires to provide an indication of No Response.  
 
19.2 Modbus Slave Overview 
 
For complete Modbus Slave instructions, please refer to the Help file in Cscape.  
 
The Modbus slave function block, when used with the appropriate Modem and/or Open 
function blocks, allows the primary serial port on the controller to act as a Modbus slave. The 
Modbus function supports both ASCII and RTU modes of operation across a range of baud 
rates and protocol frames. Also supported is port activity status, an inactivity timer, support 
for call-on exception, and support for store and forward (repeater) operation for radio 
modems.  
 
The Modbus Addressing section describes the supported Modbus Commands as well as the 
Modbus Map for XLE/XLT References (%R, %M, etc.).   
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19.3 Modbus Master Overview 
For complete Modbus Master instructions, please refer to the Help file in Cscape.  
 
When acting as a Modbus master, there are two primary mechanisms used by the XLE/XLT to 
allow the user to specify the data to be read/written from/to the slaves. 
 
Modbus Master Function Block—This is for serial only. This is an advanced feature that should 
only be used in rare occasions.   

 
Protocol Config—The Protocol Config is configured in the Hardware Configuration dialog box 
in Cscape (serial) – See the Modbus Addressing section. This is the preferred method in most 
applications.  
 
After the protocol has been selected from the dropdown menu, the Network, Devices, and 
Scan List become available. The Protocol Config is configured on three different levels: 

• Network—Parameters, such as the polling rate of the data scan, are specified along 
with timeout values, retry, and re-acquisition settings. Serial configuration, baud rate, 
parity, etc. are also set here.  

• Devices—For every slave to be polled, configuration details are added in the Devices 
dialog box. This includes Slave ID (serial). Under Device Type, the Modbus addressing 
style matching that specified in the slave’s user documentation may be selected. For 
instance, some slaves specify Modbus addresses (i.e. 40,001), and others specify 
offsets (i.e. 0000).   

o Hex or Decimal—Some specify addresses in hex, and others in decimal. By 
allowing the user to select the Modbus addressing style for each slave on the 
network, minimal address conversion is required. Also, if the slave is another 
Horner product (i.e. another OCS), the “Native Addressing” option can be 
selected (i.e. %R1, %M17, etc.), and this skips the conversion to Modbus style 
altogether. 

• Scan List—This is where the specific Modbus addresses to be read/written from/to 
each slave are specified. Up to 32 words of data can be read at the same time.  
 
NOTE: Once configuration has been completed on the Network and Devices level, 
Modbus data can be directly read/written from graphics objects in the Cscape screen 
editor. This is available even if the Modbus register is not listed on the scan list. 

   
 
The above information is just an introduction to the topic. For more detailed information, 
please consult the Cscape Help file. 
  



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  154 | 168 
 

19.4 Opening Cscape Help File  
 
After opening the Cscape Help file, select the Index table and search for “Modbus Slave” or 
“Modbus Master”, as shown below.  
 
   
 
Select “Index” tab.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
19.5 Modbus Addressing Table for XLE/XLT Units 
 
To access XLE/XLT registers, a Modbus Master must be configured with the appropriate 
register type and offset. This is usually accomplished with one of two methods: 
 
Method 1: The first method uses Traditional Modbus References, in which the high digit 
represents the register type and the lower digits represent the register offset (starting with 
Register 1 for each type). Since only four register types can be represented in this manner, 
XLE/XLT Modbus Function Blocks pack several XLE/XLT register types into each Modbus 
register type. Starting addresses of each XLE/XLT register type are shown in the Traditional 
Modbus Reference column of the Table 19.1.   
 
Method 2: The second method requires the Modbus Master to be configured with a specific 
Modbus Command and Modbus Offset. The supported Modbus commands and the associated 
offsets are also illustrated in Table 19.1 on the following page.  
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XLE/XLEe Modbus Table 
 

Table 19.1 – Modbus Master Mapping 
XLE/XLEe 
Reference 

Maximum 
Range 

Trad. Modbus 
Reference 
(5 Digits) 

Expanded 
Modbus Ref.  

(6 Digits) 

Modbus Command(s) Modbus Offset 

%I1 2048 10001 010001  
Read Input Status (2)  

0 
%IG1 64 13001 013001 3000 
%S1 13 14001 014001 4000 
%K1 10 15001 015001 5000 

 
%Q1 2048 00001 000001  

Read Coil Status (1) 
Force Coil (5) 
Force Multiple Coils (15) 

0 
%M1 2048 03001 003001 3000 
%T1 2048 06001 006001 6000 
%QG1 64 09001 009001 9000 

 
%AI1 512 30001 030001  

Read Input Register (4) 
0 

%AIG1 32 33001 033001 3000 
%SR1 192 34001 034001 4000 

 
%AQ1 512 40001 040001  

Read Holding Register (3) 
Load Register (6) 
Load Multiple Registers 
(16) 

0 
%R1 2488 40513 040513 512 
%R1 2048 43001 043001 3000 
%AQG1 32 46001 046001 6000 
%R1 9999 -- 410001 10000 
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XLT/XLTe Modbus Table 
 

Table 19.1 – Modbus Master Mapping 
XLT/XLTe 
Referenc

e 
 

Maximum 
Range 

Trad.  
Modbus 
Ref. (5 
Digits) 

Expanded 
Modbus 

Ref. 
(6 Digits) 

Modbus 
Command(s) 

Modbus Offset 

%I1 2048 10001 10001  
Read Input Status (2) 

0 
%IG1 64 13001 13001 3000 
%S1 13 14001 14001 4000 
%K1 4 15001 15001 5000 

 
%Q1 2048 00001 000001 Read Coil Status (1) 

Force Coil (5) 
Force Multiple Coils 

(15) 

0 
%M1 2048 03001 003001 3000 
%T1 2048 06001 006001 6000 

%QG1 64 09001 009001 9000 
 

%AI1 512 30001 030001 Read Input Register 
(4) 

0 
%AIG1 32 33001 033001 3000 
%SR1 192 34001 034001 4000 

      
%AQ1 512 40001 040001 Read Holding 

Register (3) 
Load Register (6) 

Load Multiple 
Registers (16) 

0 
%R1 2488 40513 040513 512 
%R1 2048 43001 043001 3000 

%AQG1 32 46001 046001 6000 
%R1 9999 -- 410001 10000 
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CHAPTER 20: TROUBLESHOOTING / TECHNICAL SUPPORT 
 
0 provides commonly requested troubleshooting information and checklists for the following 
topics.   

• Connecting to the XLE/XLT controller 
• Local controller and local I/O 
• CsCAN Network 
• Removable media 

 
If this information is not what you need, please contact Technical Support at the locations 
indicated at the end of this chapter.    
 
20.1 Connecting to the XLE/XLT 
 
Cscape connects to the local controller automatically when the serial connection is made. The 
status bar below shows an example of a successful connection. This status bar is located in the 
bottom right hand corner of the Cscape window.  
 
 
 
In general, the Target number should match the Local number. The exception to this is when 
the controller is being used as a "pass through" unit where other controllers on a CsCAN 
network could be accessed through the local controller. 
 
Determine connection status by examining feedback next to Local & Target in the status bar of 
Cscape. 
 

 
Local: ### 

 
If a number shows next to Local then communication is established to the local controller. 

 
Local: No Port 

Cscape is unable to access the COM port of the PC. This could mean that Cscape is 
configured for a COM port that is not present or that another program has control of the 
COM port. Only one Cscape window can access a port at a time. Subsequent instances of 
Cscape opened will indicate No Port. 

 
Local: No Com 

 
Cscape has accessed a PC COM port, but is not communicating with the controller. This 
typically occurs when the controller is not physically connected. 

 
Local: ??? 

Unknown communication error. Close Cscape, power cycle the controller and reopen 
Cscape with a blank project. Check Local. 

Target: #(I,R,D) 
If I (idle), R (run), or D (do I/O) shows next to Target number, then communication is 
established to the target controller. 

Target: #(?) 
Communication is not established to the target controller. Check node ID of controller and 
set Target to match. Make sure local connection is established. 
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20.1.1 Connecting Troubleshooting Checklist   
 

1. Programming and debugging can use MJ2 if it is set as the default programming port.   
2. Controller must be powered up. 
3. Assure that the correct COM port is selected in Cscape.  

Tools → Application Settings → Communications . 
4. Check that a Loaded Protocol or ladder is not actively using MJ1/MJ2. Taking the 

controller out of run mode from the System Menu on the controller will make MJ1/MJ2 
available to Cscape. 

5. Make sure the COM port of the PC is functioning. An RS-232 serial loopback and 
Microsoft HyperTerminal can determine positively if the COM port is working. Or connect 
to an alternate device to determine if the port is working. 

6. Successful communications with USB-to-serial adapters vary. If in doubt, Horner 
Automation offers a USB to serial adapter. Part number: HE-XCK. 

7. XLE/XLT units with built-in Ethernet or installed HE-XEC module can be programmed 
and debugged via the Ethernet port. If the HE-XEC is installed, it can be selected as the 
programming port. The selection is made in the controller's System Menu under the 
Serial Port settings. If there are difficulties connecting, make sure that the default 
programming port is set correctly with the connection method being attempted. 
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20.2 Local Controller and Local I/O  
 
The System Menu provides the following status indications that are useful for troubleshooting 
and system maintenance. 
 

• Self-test results, diagnostics. 
• RUN and OK status 
• Network status and usage 
• Average logic scan rate 
• Application memory usage 
• Loaded firmware versions 
• Loaded protocols 
• Removable media access 

 
 
To view the system menu, press the UP and DOWN arrow keys simultaneously. Refer to the 
System Settings and Adjustments chapter for full details on the System Menu diagnostic 
capabilities. 
 
20.2.1 Local I/O Troubleshooting Checklist   

1. Verify the controller is in RUN mode. 
2. Check diagnostics to ensure controller passed self-tests. 
       View Diags in System Menu or in Cscape, click:  Controller → Diagnostics 
3. Check data sheets to ensure proper wiring. 
4. Ensure that hardware jumpers and software configuration for I/O match. 
5. Check data sheets for voltage and current limits. 
6. Take ladder out of the picture. From Cscape set controller to “Do I/O” mode. In this 

mode inputs can be monitored, and outputs set from a data watch window in Cscape 
without interference from the ladder program. Some I/O problems are only a result 
of a mistake in the ladder program. 

 
 
 
 
  

WARNING: Setting outputs ON in Do I/O mode can result in injury or cause 
machinery to engage in an unsafe manner depending on the application and the 
environment.  
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20.3 CsCAN Network  
 
For complete information on setting up a CsCAN network, refer to CAN Networks manual 
(MAN0799) by visiting our website. 
 
Network status, node ID, errors, and baud rate in the controller system menu are all in reference 
to the CsCAN network. These indications can provide performance feedback on the CsCAN 
network and can also be used to aid in troubleshooting. Refer to the System Settings and 
Adjustments chapter for full details. 
 
20.3.1 CsCAN Network Troubleshooting Checklist   
 
1. Use the proper Belden wire type or equivalent for the network as specified in MAN0799. 
2. The XLE/XLT does not provide 24VDC to the network. An external voltage source must be 

used for other devices such as SmartStix I/O.   
3. Check voltage at both ends of the network to ensure that voltage meets specifications of 

attached devices. 
4. Proper termination is required. Use 121Ω (or 120Ω) resistors at each end of the network. The 

resistors should be placed across the CAN_HI and CAN_LO terminals. 
5. Measure the resistance between CAN_HI and CAN_LO. If the network is properly wired and 

terminated there should be around 60Ω. 
6. Check for duplicate node ID’s. 
7. Keep proper wires together. One twisted pair is for V+ and V- and the other twisted pair is 

used for CAN_HI and CAN_LO. 
8. Make sure the baud rate is the same for all controllers on the network. 
9. Assure shields are connected at one end of each segment -- they are not continuous through 

the network.   
10. Do not exceed the maximum length determined by the baud rate and cable type. 
11. Total drop length for each drop should not exceed 6m (20’). A drop may include more than 

one node. The drop length adds to the overall network length. 
12. Network should be wired in "straight line" fashion, not in a "star" pattern. 
13. In applications requiring multiple power supplies, make sure the V- of all supplies is 

connected and to earth ground at one place only. 
14. In some electrically noisy environments it may be necessary to add repeaters to the 

network.  Repeaters can be used to add additional nodes and/or distance to the network 
and protect the signal against noisy environments.  

  



  MAN0878-11-EN_XLE_XLT_UserManual 

M a r c h  8 t h ,  2 0 1 9     P a g e  161 | 168 
 

20.4 Removable Media   
 
20.4.1 Basic Troubleshooting 
 

Description Action 

XLE/XLT does not read media card. 
The media card should be formatted with 
the XLE/XLT. 

XLE/XLT will not download project file. 
Make sure the project file is saved as a 
.pgm file and not a .csp file. 

 
 
20.5 Technical Support Contacts 
 
For manual updates and assistance, contact Technical Support at the following locations: 
 
North America:   
Tel: (317) 916-4274 
Fax: (317) 639-4279 
Website: https://hornerautomation.com 
Email: techsppt@heapg.com 
 
 
Europe:  
Tel: (+) 353-21-4321-266 
Fax: (+353)-21-4321826 
Website: www.horner-apg.com 
Email: technical.support@horner-apg.com 
 
 
 
  

https://hornerautomation.com/
mailto:techsppt@heapg.com
file://///ENGSRV3/Doc_Manuals/OCS_Manuals/HE_OCS/XLE/User%20Manual/www.horner-apg.com
mailto:technical.support@horner-apg.com
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